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The Communication Accessibility Challenge 

Each day, we communicate—at home, in the car, in the classroom, in the 
workplace, or in public venues. Those of us who can speak and hear 
normally have little trouble asking or answering questions, supplying 
vital information, or engaging in effective two-way communication. 
However, these simple acts can be a struggle for persons who are deaf, 
hard of hearing, or other persons who experience unique communication 
challenges. Access to acoustic information and communication are 
challenges these individuals face daily. Interactive Solutions, Inc., a 
subsidiary of Teltronics, Inc., developed the iCommunicator software 
program to enable persons to overcome communication challenges and 
to foster literacy development and independent communication.  

The Impact of Hearing Loss  

In the United States, an estimated twenty-eight million people have a 
hearing loss during their life (ASHA, 2000). More than 30% of people 
over sixty-five, and 14% between the ages of forty-five and sixty-four 
have some hearing loss. Nearly eight million people between the ages of 
eighteen and forty-four, and seven million children have hearing loss 
(Better Hearing Institute, 2001). Approximately 1.5 million individuals, 
ages three years and older, are deaf in both ears (Collins 1997).Research 
shows that 11.3% to 14.9% of school-aged children have a hearing loss 
that affects their learning and development (Bess, Dodd-Murphy & 
Parker, 1998; Niskar et al., 1998). Carney & Moeller (1998) reported that 
early-onset sensorineural hearing loss has many consequences on a child’s 
development. For example, hearing loss alters the child’s ability to extract 
linguistic clues from auditory language models. Hearing loss limits 
opportunities to overhear information, which is how persons with normal 
hearing typically learn the nuances of the English language. This 
deprivation brings negative consequences for language rule formation, 
word knowledge, and vocabulary development. Subsequently, many with 
hearing loss experience other unique communication challenges. 

Classrooms are auditory-verbal environments. However, most of 
America’s 92,012 schools do not provide students with hearing loss or 
auditory based learning challenges with the acoustic accessibility needed 
to fully comprehend messages. Noise, reverberation, and distance from the 
speaker compromises the student’s speech perception abilities, even when 
he or she uses advanced signal processing, personal amplification 
equipment, or other assistive devices. The student needs access to the 
spoken word.  
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Listening is important to everyone, but it is more challenging for the 
person with hearing loss, because he or she may not have a rich linguistic 
background to help them eliminate the disparity during lectures, 
directions, and conversations. Adults spend 45% of their day involved in 
the listening process, but children spend 60% to 75% of their day listening 
(Butler, 1975; Dahlquist, 1997). These communication challenges often 
present barriers to listening and learning. 

The Impact of Literacy Deprivation 

Concern about the literacy levels of some persons who are deaf or hard of 
hearing was the inspiration for developing the iCommunicator software 
program. Often, students with hearing loss do not progress at the same rate 
as their hearing peers. More often, they only achieve only one-third of a 
grade advancement during an academic year (Wolk & Allen, 1984). The 
cumulative effect of this underachievement is that many deaf or hard of 
hearing students graduate from high school with a fourth grade reading 
comprehension level (Holt Traxler, & Allen, 1997). These lower literacy 
levels present barriers to post-secondary education. While 53.7% of high 
school graduates attend college, only 33.4% of students who are deaf 
pursue post-secondary education (Fairweather & Shaver, 1991). 

Other Persons with Special Communication Needs 

The iCommunicator program was initially developed as a solution for 
persons who are deaf or hard of hearing, giving them opportunities to 
achieve communication independence. However, the program has 
applications for many individuals who face unique communication 
challenges. For example, those with an auditory processing disorder, 
learning disability, and/or severe language impairment, or who experience 
difficulty with multitasking, may benefit from the iCommunicator 
program with its sophisticated note-taking technology. Persons with a 
specific learning disability, known as dysgraphia, and others with motor 
disabilities may also benefit from the program’s ability to communicate 
and note-take during classes, discussions, and meetings. Systematic 
evaluation of a person’s unique communication needs and the 
iCommunicator program features will determine if the iCommunicator 
program is an an appropriate assistive technology.  

Individuals with significant, expressive speech or voice disorders may 
benefit from the voice output capabilities that allow them to interact 
independently during conversations. The iCommunicator program 
provides applications that assist with these needs through the 
developmental or recovery process. Visual acuity and visual perceptual 
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deficits also necessitate special communication accessibility. The size of 
the visual display and background/foreground contrast, are two needs  the 
iCommunicator program accommodates. Another very large group with 
special communication needs are those whose native language is not 
English. Refer to Appendix A for additional information about factors to 
consider when evaluating the iCommunicator program as an assistive 
technology. 

Access to Sign Language 

In the United States, there is a critical shortage of sign language 
interpreters. It is estimated that there are approximately 40,000 interpreters 
nationally, though less than 25% of them hold certification. Altlhough the 
iCommunicator program is not intended to replace sign language 
interpreters, it can serve as an alternative access technology for people 
who communicate in sign language. The iCommunicator software 
program delivers American Sign Language (ASL) signs in English word 
order (subject+verb+object). Using this manually-coded English system, 
users can improve the association between spoken, written, and signed 
words, and improve literacy skills. The iCommunicator video sign 
language library has more than 9,200 individual video clips. 

Rationale for Selecting iCommunicator’s Sign Language Lexicon  

The selection of signs for the iCommunicator program’s signing lexicon is 
based on the goal of using this unique software application to enhance 
communication and literacy skills. As children begin to develop reading 
and writing skills they become aware of print in the environment and the 
use of print by others. Children start to understand and use written 
symbols before formal instruction in school.  In order to understand 
written material, children must understand the written structures that are 
used. Simple sentences that follow subject+verb+object (S+V+O) 
structures are easier for children to understand than sentences with more 
complex structures.  

Individuals who are deaf may use American Sign Language (ASL), Pidgin 
Sign English (PSE) (also known as contact signing), Manually Coded 
English (MCE), or English to communicate in face-to-face situations. ASL 
is a visual-gesture language with a rule structure that is different from 
English and other languages and has a very limited written format. 
Manually Coded English is a sign system that represents English in a 
visual-gesture modality. Manually Coded English was designed to make 
English visible. The three best known Manually Coded English systems in 
educational programs for students who are deaf are seeing Exact English 
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(SEE I), Signing Exact English (SEE II), and Signed English (Coryell & 
Holcomb, 1997; Gustason & Zawolkow, 1993). These manually coded 
English systems consist of a set of invented signs to represent English 
structures, such as pronouns, verb tenses, plurality, adverbs, possessives, 
comparatives, and articles. Pidgin Sign English, or contact sign, refers to 
the use of ASL signs in English word order, with some inclusion of 
English morphemes. PSE, or contact sign, is not a language in itself, but 
an incomplete version of ASL and an incomplete version of English.  

Students with special needs are placed in a variety of educational settings 
to meet their educational needs. Options range from inclusive settings 
(regular education classes) to segregated classes (self-contained special 
education classes or residential schools). The increased emphasis on 
placing students in inclusive classes stresses the importance that students 
have good communication and literacy skills. Parents’ abilities to 
communicate with their children, as well as their active involvement in 
their children’s education, and children’s desire to actively interact with 
peers in all environments, support the need to develop children’s English 
skills.  

To support an individual’s improvement of communication and literacy 
skills, the use of the S+V+O structure is used as a basis for the selection of 
signs for the iCommunicator program’s signing lexicon. The S+V+O 
structure enables children to learn the English language. For other 
applications of the iCommunicator software program, such as the 
workplace, English word order delivery of sign language is judged to be 
the most appropriate delivery mode. The use of real-time captioning and 
signing, as needed, are beneficial to the communication and language 
development of a variety of special learners, including persons who are 
deaf, deaf-blind, visually impaired, autistic, or aphasic. It also has 
applications for persons with motor problems or difficulties in 
multitasking, persons with specific learning disabilities, and other persons 
with unique communication challenges.  
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An Interactive Communication Access Solution 

The iCommunicator™ software program, Version 4.0, is a leading edge 
communication access technology. This very powerful tool provides a 
multisensory, interactive communication solution for persons who are deaf 
or hard of hearing and other persons who experience unique 
communication challenges. While the iCommunicator software program 
promotes independent communication for persons who are deaf or hard of 
hearing, it is offered as an alternative, rather than a replacement, for sign 
language interpreters.  

 

Real-time Translation 

This advanced speech-to-text technology is the first of its kind to enter the 
marketplace. It allows effective communication to occur in most natural 
environments. Dragon NaturallySpeaking Professional, Version the 
underlying speech recognition engine, offers many features to personalize 
a speaker’s speech and voice recognition (S/VR) file and enhance 
translation accuracy. The iCommunicator program efficiently converts in 
real-time:  

 speech to text  

 speech to video sign language  

 speech to computer-generated voice  

 text to computer-generated voice or video sign language  
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End User Benefits  

The iCommunicator program’s unique technological features provide end 
users with unparalleled opportunities to achieve efficient, effective 
communication in most natural environments. End users have the chance 
to:              

 increase spoken language comprehension 

 achieve two-way communication 

 improve reading and language skills 

 increase independence and self-confidence and improve quality of life 

 increase opportunities for advancement and success in education, 
employment, personal relationships, and public access venues 

Version 4.0 Software and Peripheral Kit 

The iCommunicator software program, Version 4.0, runs on a high-end 
laptop or desktop computer that meets the minimum hardware 
requirements. (Refer to the minimum hardware requirements on page 20.)  
Version 4.0 offers an enhanced sign language presentation, easy auto-load 
self-installation, and major code changes to ensure a reliable and efficient 
program. Simply point and click. The new iText tool will sign and/or read 
email, web pages, or other documents. Owners can easily install the 
software on their own computer using the auto-load installation guide. 

The 4.0 software and peripheral kit includes: 

 iCommunicator Software Kit V 4.0 

 Dragon NaturallySpeaking Professional  

 iCommunicator User Guide and Training Manual 

 Hardware security key (dongle) 

 Audio Cables (connector cable, Y-cable) 

 Microphone options wireless or wired 

 Professional - LightSPEED LES 360 wireless RF system with TK-
250 noise canceling microphone (LightSPEED system includes 
360R receiver, 360T transmitter and TK-250 microphone, BC-4 
battery charger & cables, 2 NiMH rechargeable batteries.) 

 Standard - Parrott Bermuda direct-connect microphone  
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The manufacturer has qualified the LightSPEED and Parrott units as the 
only high quality microphones that are compatible with the 
iCommunicator software in order to achieve maximum translation 
accuracy. Prior to shipping, the LightSPEED system is professionally 
calibrated to optimal settings to support maximum performance and 
translation accuracy. The computer also may be coupled with peripheral 
assistive hearing devices such as personal FM systems, hearing aids, and 
cochlear implant speech processors. When used on a laptop computer, 
iCommunicator technology becomes a portable, interactive solution to 
communication accessibility challenges in multiple communication 
environments—educational, workplace, and public venues. Warranty 
software support is available for 90 days.  

Systematic Evaluation and Recommendation 

The manufacturer supports careful and systematic evalution of potential 
end user needs and the iCommunicator program features to ensure that this 
software technology application is a viable solution. To promote positive 
outcomes, evaluation and planning teams must determine if the 
iCommunicator is the right technology for the right end user, and then 
implement the program in the right way. Various federal regulations 
specify entitlements to assistive technology. State and local interpretations 
should guide assistive technology evaluation teams. Refer to the 
Candidacy Criteria Considerations and Individuals with Communication 
Challenges: The Need and Feature Match documents in Appendix A for 
further information regarding factors to consider in determining if the 
iCommunicator program is the appropriate assistive technology for a 
specific end user. 

Training to Ensure Positive Outcomes 

The iCommunicator program uses continuous recognition of natural 
speech to translate speech to text and/or sign language in real time. 
Systematic professional training is strongly encouraged to maximize use 
of the unique features and capabilities of the program. The end user must 
be completely trained in the operation of the iCommunicator program to 
achieve positive outcomes, and adequate supports will need to be available 
for the end user for technical assistance and support. Managers of the 
iCommunicator program should possess computer literacy skills necessary 
to use and maintain the program and peripherals and provide training for 
both end users and speakers in the unique features of this communication 
access technology. Speech and voice recognition enhancements available 
in iCommunicator program, V 4.0, allow most speakers to easily achieve 
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90% or better translation accuracy with approximately one hour of speech 
and voice recognition (S/VR) training. Additional time is required to 
customize the speaker’s S/VR file by adding unique vocabulary specific to 
the speaker’s profession or worksite application.  

Section 508 Compatibility 

The manufacturer is committed to helping the government, as well as 
private and public sector businesses, provide improved accessibility of 
information and technology through its products, information, services, 
and programs. As such, the iCommunicator website and software 
application meet Section 508 requirements for electronic and information 
technology accessibility. The iCommunicator program is fully 508 
compliant in the Standard viewing mode, and following are some of the 
features. 

 iCommunicator program works correctly with the Accessibility Aids 
Microsoft bundles with the Operating System. 

 In Standard mode, all menus display Alt key combinations. 

 A microphone on/off choice has been added to the Options menu in 
Standard mode and a visual microphone on/off button has been added 
to the control window.  

 Text Window options have been added on the menu bar in Standard 
mode.  

 The Change Speaker choice has been added to the Options/Speech 
Recognition menu. 

 The program is now 16-bit color compatible. 

Special Features for End Users 

The iCommunicator program’s unique technological features provide end 
users with unparalleled opportunities to achieve efficient and effective 
communication. The signing engine has been rewritten to be faster, more 
efficient, and more accurate. 

Translation Actions and End User Options 

 translates spoken language to real time on-screen text 

 adjust the font size for comfortable viewing 
 adjust the size of the Text Window (custom mode) 

 translates spoken language into sign language 
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 signs on-screen text 

 adjust the signing speed 
 adjust the size of the Signing Window (custom mode)  
 locate a sign using the Word List feature 

 speaks on-screen text using a clear computer-generated voice 

 select the speaking voice (e.g., male or female) 
 adjust the pitch and rate (i.e., speed) of the computer-generated 

speech 
 deliver written manuscripts and reports using computer-generated 

speech 
 listen to stories or lectures delivered via computer-generated 

speech 

Other Unique Features and Capabilities 

 save text for later use, editing, or clarification 

 insert notes into real time text for later reference 

 formulate questions and statements for immediate response in class, 
during meetings, or during personal conversations 

 prepare and execute formulated statements and questions using Quick 
Say/Edit function keys 

 quickly navigate the keyboard using hotkeys 

 choose a desirable, personalized color scheme  

 select a comfortable mode of computer use - standard or custom mode 

 lock signing (if preferred) 

 protect notes by using Autosave and selecting the time interval 

 eliminate unwanted translations by using the onscreen microphone 
ON/OFF button 

 use iText to have email (and other documents) signed and/or read 

Potential to Improve Speech Recognition and Intelligibility 

 speaks incoming words to enhance speech recognition 

 playback of text converted to speech at variable rates to improve 
speech recognition and intelligibility 

 couple with peripheral hearing devices (e.g., hearing aids, FM systems, 
cochlear implant speech processors) directly to the computer with the 
audio Y-cable to clearly hear the computer-generated voice 
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Enhance Language and Literacy Skills 

 find word definitions using an integrated, electronic dictionary 

 view the sign for a specific word  

 allows immediate text display using Show Results Box 

 associate spoken words with displayed text and sign language that is 
delivered in English word order 

Special Features for Speakers 

The iCommunicator program’s exclusive features provide speakers the 
opportunity to easily and directly converse with people that have special 
communication needs. 

 enhanced speech and voice recognition translation accuracy through 
iCommunicator’s expertly integrated program 

 user-friendly, on-screen prompts and dialogue boxes to assist speakers 
during speech/voice recognition training 

 speaker verification window to protect the user’s speech/voice files 

 opportunity for most speakers to achieve 92% (or better) speech and 
voice recognition translation accuracy in approximately thirty minutes  

 fine tuning of the speech/voice file through a guided vocabulary 
building process 

 decrease speech/voice recognition training time by analyzing 
electronic documents, such as texts, manuscripts, scanned materials, 
summaries, glossaries, and vocabulary lists 

 fine-tune the speech/voice recognition file using special features in 
Dragon NaturallySpeaking, such as the Accuracy Center and the 
Acoustic Optimizer 

 directly communicate with persons who have special communication 
needs 

iCommunicator Training Overview 

Assistive technology (AT) service, as specified in the Individuals with 
Disabilities in Education (IDEA) 1997 Amendments (§300.6), requires 
that training or technical assistance be provided for a child with a 
disability, and if appropriate, the child’s family. This would apply to the 
iCommunicator software program, if it is recommended by the 
evaluation/planning team as an appropriate AT. The IDEA also requires 
AT training be provided for professionals delivering educational or 
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rehabilitation services, employers, or other individuals who provide 
services to, employ, or are in any other way substantially involved in the 
child’s major life functions. As such, local education agencies (LEAs) 
have a responsibility to remove barriers to the use of AT to enable a 
student to have independence in major life functions, one of which is 
communication. For applications in the workplace, higher education, 
public access venues, and other sites, systematic training is encouraged to 
maximize the potential of the iCommunicator program for both end users 
and speakers. Accessibility in workplace environments and public venues 
is addressed in other regulatory authorities described in Appendix C. 

Purpose and Value of Training 

It is critical that end users, speakers, and managers of this assistive 
technology receive appropriate training in order to achieve maximum 
benefits from the program. Successfully trained persons will be able to use 
and maintain the iCommunicator program and peripherals in an efficient 
and effective manner for all applications of the technology. Thus, the 
investment made in customized professional training will provide owners 
with the accountability necessary to ensure that the program can be 
properly implemented. 

Who Should Participate in iCommunicator Training 

The manufacturer recommends that those responsible for managing the 
program implementation participate in the professional training. This 
“train the trainer” approach ensures that the owner has key people trained 
in all aspects of the program, including use and application. The trainer is 
then responsible for training both speakers and end users, and serves as 
implementation manager. We recommend that speakers and managers be 
adept at the computer skills comparable to those offered through a 
Beginning Windows 98 course.  

Prerequisite skills required:  

 basic knowledge of Windows 98 (ability to modify the basic computer 
environment, multitasking, and file management) 

 keyboard familiarity (how to type, familiar with shortcuts) 

 use of the mouse (how to move the mouse; how to point and click, 
double-click, and click and drag) 

 familiarity with menu commands 

 familiarity with navigating windows (activate, move, resize, minimize, 
maximize, restore) 
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 familiarity with opening, closing, and saving simple documents 

 ability to navigate to and select folders, sub folders, and the documents 
contained within 

Training Delivery Model 

The User Guide and Training Manual provide implementation managers, 
speakers, and end users with useful information pertinent to the effective 
use of the software program and peripherals. Contact 1450, Inc. for more 
information about training options. 

Master Inservice Component: iCommunicator Training 

The master in-service training component meets professional continuing 
education activity requirements. The training module includes goals, 
objectives, and a training activity description. 

General Objectives 

The iCommunicator training helps the participant: 

 understand the basics of the iCommunicator program 

 understand the program applications  

 navigate the program 

 accomplish speech and voice recognition training  

Goals 

Training helps you achieve the following goals: 

 demonstrate the iCommunicator features and capabilities  

 present the user and speaker features  

 determine if the iCommunicator program is the right technology for an 
end user 

 describe applications for all users 
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Learner Objectives 

The iCommunicator training will help you to: 

 identify the iCommunicator program’s capabilities and who will 
benefit from them 

 identify specific features and enhancements  

 set up the system components and perform a System Check  

 understand the speech and voice recognition training process 

 perform speech/voice recognition training  

 achieve at least 90% accuracy using the speech/voice training process 

 analyze text documents and build vocabulary  

 fine-tune the speaker’s speech/voice recognition file 

 demonstrate the iCommunicator program when delivering on-line text 
and other data streams with at least 90% accuracy 

 demonstrate knowledge of the troubleshooting tips  

Using the iCommunicator Training Manual 

This manual assists end users, speakers, and managers to learn and use the 
unique features of the iCommunicator (V.4.0) software program, and 
introduces related concepts and program functions. It includes four 
modules: iCommunicator Program Overview, Menus and Windows, 
Speech and Voice Recognition Training, and Vocabulary Building. Each 
module begins with a preview that covers concepts and objectives. Each 
module includes procedures, explanations, demonstrations, illustrations, 
and exercises. A brief review and practice session conclude each module 
to help reinforce understanding of the information presented. Useful iTips 
and reference materials are provided at the end of the modules and in the 
Appendices. 

During the training, you will access text files to complete some of the 
exercises in this manual. Later, you will open the vocabulary file 
(vocab.rtf) and add your name, additional names, technical terms, and 
other words and phrases. You will analyze these words and phrases during 
vocabulary building exercises.  
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You can download the training text files from the website at 
www.myicommunicator.com. Follow the steps below to download the 
text files. 

1. Select Product Information from the left panel of the webpage. 

2. Select Product Download from the top panel of the Product 
Information page. 

3. Select Vocabulary Files.  

4. An Authentication Screen will appear.  

a. User Name: Vocab 

b. Password: dragonflies  

5. Click OK. 

The File Download screen will appear.  

6. Select Save and specify where you would like to save the file. 

7. Select Open to access the text files. 
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Module 1 Objectives 

In this module, you will learn the skills necessary to: 

 use the transmitter and position the microphone 

 connect the receiver 

 connect the audio outputs 

 manage battery usage 

 perform a System Check 

 open the iCommunicator program 

Preview:  iCommunicator Program (V 4.0) Kit Overview 

The iCommunicator, Version 4.0 program has many enhancements that 
distinguish it as a patented, leading edge communication access 
technology. Some key features in V.4.0 include: 

 Dragon NaturallySpeaking Professional – speech and voice 
recognition engine underlying the software for the highest speech-to-
text translation accuracy in the industry 

 LightSPEED FM system compatibility with Phonak’s Microlink, the 
Phonic Ear Sprite, and other wireless FM systems transmitting on 216 
MHz 

 Sign language video library – re-engineered sign for maximum 
translation efficiency 

 iText tool – allows email, web pages, and documents created in other 
applications to be signed and/or spoken through the iCommunicator 
program. 

The iCommunicator program works with a Pentium III-based multimedia 
laptop or desktop computer that meets the minimum hardware 
specifications identified by the manufacturer. 

The software includes: 

 iCommunicator V.4.0 software kit 

 Dragon NaturallySpeaking Professional  

 Babylon Translator 
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The iCommunicator program runs efficiently on Windows 98, Windows 
2000, and Windows XP operating systems. Dragon NaturallySpeaking 
Professional is the underlying speech recognition engine 
incorporated into the iCommunicator program. This speech/voice 
recognition software program has the highest industry rating for 
translation accuracy and training time for speakers to establish their 
speech/voice profile has been reduced significantly. Version 4.0 software 
is easily installed by the owner when following the step-by-step procedure 
described in the Install Guide. 

Version 4.0 software is available as a professional version or a standard 
version, and the difference is the microphone used to input the speaker’s 
voice. The professional version includes the LightSPEED 360 wireless 
FM system and the standard version includes the Parrott Bermuda wired, 
direct-connect microphone. The manufacturer has qualified the 
LightSPEED and Parrott units as the only high quality microphones that 
are compatible with the iCommunicator software in order to achieve 
maximum translation accuracy. The manufacturer will take no 
responsibility for product failure if the purchaser uses an alternative 
microphone.  

Prior to shipping, the LightSPEED system is professionally calibrated to 
optimal settings to support maximum performance and translation 
accuracy. The manufacturer has selected an upgraded LightSPEED noise 
canceling microphone for use with the iCommunicator software to 
enhance translation accuracy. Owners of the iCommunicator program 
should consult the product literature for the microphone shipped with their 
software kit for further details. 

Speech recognition software is what the iCommunicator software program 
uses to translate speech. Translated words can be sent to an external 
source using a double wire cable, called the Audio Y-cable. One end of 
the Y-cable plugs into the laptop, the other cable end splits into two plugs. 
The yellow-coded plug may be connected to a peripheral hearing device, 
such as a cochlear implant speech processor, FM system, or personal 
hearing aid. The blue-coded plug may be connected to external speakers if 
the end user requires this option for voice output. 
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iCommunicator Program and Hardware Connections 

When setting up your computer, consult the appropriate user information 
that accompanies your computer. Information in the iCommunicator 
User’s Guide, the Install Guide, and product literature for your specific 
microphone should be consulted for details regarding use of the 
iCommunicator software and peripherals. Before you power on the 
computer, connect all hardware and verify that all cables are secure. 

Minimum Computer Hardware Requirements 

The iCommunicator V.4.0 software program operates on a high end laptop 
or desktop PC platform using a Pentium III-based multimedia computing 
system that meets the minimum hardware specifications. For enhanced 
performance, a 1 GHz processor and 512 MB RAM is recommended. 
 

Processor Pentium III 800MHz 
Memory 256 MB RAM 
Hard Drive Must have 2 GB of available space on Drive C 
Parallel Port Must have parallel port to attach hardware security key 
Video 8MB 
Display 
Resolution 800x600 screen area capability; high quality 

Sound/Speakers SoundBlaster Pro Compatible 
CD-ROM 24X (or DVD-ROM) 
Software Word Processing Program  

Operating 
System 

Microsoft Windows XP, Windows 2000, or Windows 98SE (The 
manufacturer recommends Windows XP or 2000 for maximum 
performance.) 

 
When you operate the laptop on battery power, the battery should last for 
about two hours. Connect the power cord to the laptop computer. If your 
computer is a desktop PC, connect the keyboard, mouse, and monitor 
before you turn it on. You may need a power strip or appropriate extension 
cord if the computer is not close to an electrical outlet. Connect the 
hardware security key.  

Microphone 

A clear input signal is required for the iCommunicator software program 
to achieve accurate speech translation.  
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The iCommunicator V.4.0 Professional Kit includes the LightSPEED 
LES 360 wireless FM system, which includes the 360R receiver, 360T 
transmitter and TK-250 microphone, BC-4 battery charger and cables, and 
two NiMH rechargeable batteries. The speaker wears a battery operated 
transmitter and headset microphone that allows the speaker to transmit 
from anywhere in the classroom, workplace, or other environment. The 
transmission range is approximately 300 feet.  

Speech broadcasts from the transmitter over a designated frequency to the 
receiver, which is connected to the computer with the color-coded audio 
connector cord. Before shipping, the LightSPEED system is professionally 
calibrated to optimal settings to support maximum performance and 
translation accuracy. 

The iCommunicator V.4.0 Standard Kit includes the Parrott Bermuda 
microphone, which is connected directly to the computer using the 
microphone jack.  

The manufacturer will take no responsibility for product failure if the 
purchaser uses an alternative microphone. 

LightSPEED LES 360 System 

The LightSPEED LES 360 system transmits on 216 MHz. The system has 
two frequency channels that are designated on the back of the receiver and 
transmitter. The LES 360R receiver and the LES 360T transmitter must be 
set to the same frequency channel for speech transmission to occur. Refer 
to the LightSPEED Wireless Transmitter & Receiver Setup guide shipped 
with your kit for additional information.  

Setup Summary: 

1. Connect the 360R receiver to the computer’s microphone input jack 
using the color-coded audio connector cord.  

2. Connect the TK-250 noise canceling microphone to the microphone 
jack on the 360T transmitter.  

Note: The transmitter does not connect to the computer. The TK-250 
microphone must be connected to the transmitter and not directly to 
the computer when performing speech-to-text translation. 

3. Check the Channel Selector Switch on the side of the 360R receiver 
and 360T transmitter to make certain that both are set to the same 
frequency channel. 
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4. Place the TK-250 headset with the arms of the headband above the 
ears and the headband around the back of the head. Resize the 
headband by stretching it farther apart or rolling the loop into a tighter 
circle. 

 

 

 

 

 

 

 

 

 

 

 

 

5. Position the boom microphone along the left jaw line, about an inch 
from the left corner of the mouth. The rounded portion of the 
microphone element should be positioned in front of the chin and not 
directly in front of the mouth. The flat side of the microphone is 
directed away from the face. The microphone should always be placed 

LightSPEED 360 
Receiver 
1. Charger Input Jack 
2. Channel Selector Switch 
3. Power Switch 
4. Audio Volume Control  
5. Power Indicator LED 
6. Audio Connector Cable 

LightSPEED 360 
Transmitter 
1. Charger Input Jack 
2. Channel Selector Switch 
3. Power Switch 
4. Mic Switch  
5. Power Indicator LED 
6. TK-250 Mic Connection Jack 

Connect TK-250 
microphone here. 
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in the same position to ensure translation accuracy. Squeeze the 
microphone through the windscreen to check the position.  

Note: The manufacturer selected 
the TK-250 noise canceling 
headset microphone for its ease of 
use, comfort, and ability to capture 
critical speech elements necessary 
for high translation accuracy. The 
headset microphone must be worn 
on the head to obtain the very best 
signal.  

6. Turn on the Power switch on the 
360R receiver and 360T 
transmitter. 

7. Locate the Mic Switch on the 
transmitter. Use this control as the 
mute switch to prevent 
transmitting unwanted verbiage or 
other sounds. The Mic Switch 
must be turned on in order to 
transmit speech. 

Battery Management: 

 

The BC-4 Battery Charger is used to charge the NiMH batteries provided 
with the LES system. To maximize the life of the batteries, charge them 
nightly and do not allow them to drain completely.  

LightSPEED TK-250 microphone 
worn in the correct position.            
(Illustration courtesy of 
LightSPEED Technologies.) 
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1. Turn off the power on the receiver and transmitter before charging. 

2. Insert one end of the charging cable into the battery charger and the 
other end into the charger jack on the receiver and the transmitter. The 
red LED on the charger should light when the batteries are charging.  

If alkaline batteries are alternatively used in the LES system, do not 
attempt to recharge these batteries. It will damage the system. Be sure to 
match battery polarity (i.e., + and – terminals) when replacing batteries in 
the receiver and transmitter. The batteries should fit snugly against the 
contacts. Every two or three months, clean the battery contacts with a 
deoxidizer, such as alcohol.  

The rechargeable batteries shipped with your FM system should offer 
maximum performance for 12 months. This is based on usage for 8 hours 
per day, 5 days per week. The most frequent problem associated with 
wireless FM systems is directly related to low battery power.  

For additional information about the FM system, consult the iTip: 
LightSPEED LES 360 Systems: Troubleshooting and Maintenance chart 
on page 29 or the LES 360 User Manual shipped with your kit. 

The LightSPEED LES 360 system is compatible with other peripheral 
hearing devices that transmit in the 216MHz frequency. The FCC Channel 
References iTip on page 30 provides information about the frequency 
channels of other FM products that are compatible with the eight 
frequencies available on the LES 360 system. Whenever possible, match 
the frequency channel with other FM systems so that the speaker will need 
to use only one transmitter. It is recommended that you use only the LES 
transmitter on these matched frequencies. Consult with an audiologist to 
ensure that the appropriate frequency channels are selected to 
accommodate the various FM products. 
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Parrott Bermuda Microphone 

The Parrott Bermuda Microphone accompanies the Standard Version Kit. 
The Parrott Bermuda is a noise canceling electrets microphone. In order to 
use this microphone, simply insert the 
pink microphone plug into the 
microphone input jack on the computer. 
Use the inline mute switch to avoid 
transmitting unwanted verbiage while 
using the iCommunicator software 
program for speech-to-text conversion. 
Push “in” to mute and push again to 
engage the microphone.  

The headset may be worn with the 
swivel microphone on either side of the 
face. Position the microphone along the 
jaw line. The flat part of the Parrott 
Bermuda microphone should be located 
one finger-width from the corner of the 
mouth. For voice conversion, you will 
not need to be concerned with the 
Parrott Translator, which is the plastic 
case between the microphone line and 
the microphone plug. 

Hardware Security Key 
 

The hardware security key shipped with your kit must be attached to your 
computer’s parallel port in order for the iCommunicator software program 
to run on your computer. Sometimes computers do not immediately 
recognize the hardware security key and an error message occurs when 
you attempt to open the iCommunicator program. If this occurs, it will be 
necessary to make an adjustment to the parallel port setting on your 
computer. Consult the iTip: Getting Your Computer to Recognize the 
Hardware Security Key at the end of this module for further information. 

Audio Y-cable Connector 

This unique iCommunicator accessory lets you connect the computer to 
both standard speakers and peripheral hearing devices, such as cochlear 
implant speech processors, personal FM systems, or personal hearing aids. 

1. Connect the Y-cable to the headphone jack on the computer. 

2. Connect the cable end marked with the yellow band to the cochlear 
implant speech processor, personal FM system, or hearing aid. This 

Parrott Bermuda 
Microphone 

(Photograph courtesy of VXI Corp.)
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allows the end user to listen to the speaker’s voice converted to 
computer-generated speech, or to listen to the computer read a text file 
such as an e-story downloaded from the Internet or informational 
documents. 

3. Connect the audio end marked with the blue band to external speakers 
if the end user requires voice output.  

System Check 

Before using the iCommunicator software program, complete a System 
Check. A System Check should also be performed at any time when there 
are speech/voice translation accuracy problems. The System Check iTip 
found on page 33 addresses the following keys to successful operation. 

 power (computer, receiver, transmitter) 

 battery status (computer, receiver, transmitter) 

 connections (power, audio connectors, microphone) 

 frequency setting (transmitter and receiver) 

 microphone placement 

 other programs running on the computer (including screensavers) 

Software 

The iCommunicator software kit includes the iCommunicator software 
program, Version 3.1; Dragon NaturallySpeaking Professional 
speech recognition software, and Babylon Translator. The 
iCommunicator program runs on Windows 98SE, Windows 2000, and 
Windows XP operating systems. Speakers are encouraged to become 
familiar with helpful features within Dragon NaturallySpeaking 
Professional, such as the Accuracy Center and the Acoustic 
Optimizer. 

Install the iCommunicator V.4.0 software according to the Install Guide 
that was shipped with your software kit. 

If you have purchased the iCommunicator V.4.0 software program and do 
not have a previous version installed on your computer, you will be 
completing a new installation. After installation you will be directed to 
immediately Create a New User, that is, build a speech/voice recognition 
file. This is necessary so that you will be able to speak to your computer 
and have it recognize your S/V characteristics. Refer to Modules 3 and 4 
in the Training Manual for directions. 
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If you currently have the iCommunicator software V.2.1.1 installed, you 
will follow the iCommunicator V.4.0 Upgrade Procedure. It is necessary 
to uninstall Dragon NaturallySpeaking Preferred, before 
installing Dragon Naturally Speaking Professional. The 
speaker will need to create a new speech/voice file. 

The User Guide and Training Manual are excellent references that will 
guide you through this process. These documents also contain additional 
information to benefit end users, speakers, and implementation managers. 

Coupling Peripheral Hearing Devices with the iCommunicator 

You can couple peripheral hearing devices with the iCommunicator to 
clearly hear the computer-generated voice. Coupling options vary, 
depending upon the specific peripheral device. Contact the audiologist at 
Interactive Solutions for information about specific coupling options. 
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Opening the iCommunicator Program 

Turn ON the computer. 

The iCommunicator program works best 
when no other programs are running. 
Other programs should not be open, as 
this slows the speech conversion process. 
If you choose to install other programs, do 
not place them in the start up menu. 

You can start the iCommunicator program 
using several methods, depending on the computer system set-up. Use one 
of the following methods to start the program. 

 Double-click the iCommunicator icon on the desktop. 

 From the Start button at the bottom of the computer screen, select 
Programs  iCommunicator. 

A series of messages appear on the iCommunicator’s splash screen as the 
program loads. The program opens to the iCommunicator’s main screen 
(shown below). The iCommunicator program is now ready for use.  

 
 

iCommunicator Main Screen 
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Module 1 Review 

True or False 
____ 1. The iCommunicator program runs efficiently when other programs are open 

and in use on the computer. 
 

  
____ 2. A lapel microphone is just as effective as a headset microphone. 

 
 

  
____ 3. The frequencies selected on the transmitter and receiver must match. 

 
 

  
____ 4. The Y-cable enables you to output synthesized speech to both external 

speakers and specialized hearing assistive devices. 
 

  
____ 5. The iCommunicator program runs most efficiently on a Pentium III computer. 

 
 

  
____ 6. The transmitter must plug into the computer using the audio connector cord in 

order to transmit speech.  
 

  
____ 7. The headset microphone can be worn around the neck and still achieve the 

same high quality speech signal for speech/voice recognition. 
 

 
Check your answers using the Answer Key in the back. 
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Getting Your Computer to Recognize the Hardware 
Security Key 
 
The hardware security key shipped with your kit must be attached to your 
computer’s parallel port in order for the iCommunicator software program to 
run on your computer. Sometimes computers do not immediately recognize the 

hardware security key and an error message occurs when you attempt to open the iCommunicator 
program. For example, “E0209 - Hardware Key Not Found or a similar message may display”. 
 
If this occurs, it will be necessary to make an adjustment to the Parallel Port Setting on your 
computer. Follow the steps listed below to make the adjustment. After you have changed the 
setting, the iCommunicator program should recognize the hardware security key and you will be 
able to successfully use the program. The examples provided in these directions refer to making 
this adjustment on a Compaq computer. 
 

1. Power on your computer. 
 
2. As the first splash screen appears (usually the computer company name), press the 

appropriate key(s) to enter the ROM based setup. For instance, Compaq generally uses 
the F10 key. However, this will vary from one computer manufacturer to another.   

 
3. On Compaq computers, select Device Options. For other manufacturers choose the 

appropriate menus to access the device options. 
 

4. Select Parallel Port Mode. Change the setting to Standard Mode or ECP. It should 
never be set to Bi-Directional. 

 
5. Press F10 to Accept the change, or the appropriate Save function. 

 
6. On Compaq PCs go to the File menu. Select Save Changes and Exit. A verification 

screen appears (Are you sure you want to save changes and exit?). Press F10 (yes) to 
accept the changes and exit. The steps that are required to Save and Exit will be different 
on different manufactures PCs. 

 

For further information, contact Customer Service at 800-245-2133 
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FCC Channel References 

The LightSPEED LES 360 has eight frequency channels available, 
which are compatible with frequencies of other FM systems (i.e., 
Phonak, AVR, Phonic Ear) that transmitted on 216 MHz. Whenever 
possible, matching frequencies will require a speaker to use only one 
transmitter. 

FCC                    
Channel  

Frequency in 
MHz 

 
LightSPEED

 
Phonak 

 
AVR 

Phonic 
Ear 

1 216.0125 0125 N 01 C 01 0125 
2 216.0375  N 02   
3 216.0625     
4 216.0875  N 04   
5 216.1125  N 05 C 05 1125 
6 216.1375     
7 216.1625     
8 216.1875  N 08   
9 216.2125 2125 N 09 C 09 2125 
10 216.2375     
11 216.2625     
12 216.2875 2875 N 12 C 12 2875 
13 216.3125  N 13   
14 216.3375     
15 216.3625     
16 216.3875  N 16 C 16 3875 
17 216.4125  N 17   
18 216.4375 4375 N 18 C 18 4375 
19 216.4625     
20 216.4875     
21 216.5125  N 61 C 21 5125 
22 216.5375  N 62   
23 216.5625     
24 216.5875 5875 N 64 C 24 5875 
25 216.6125  N 65 C 25 6125 
26 216.6375     
27 216.6625     
28 216.6875  N 68   
29 216.7125  N 69 C 29 7125 
30 216.7375     
31 216.7625     
32 216.7875 7875 N 72 C 32 7875 
33 216.8125  N 73 C 33 8125 
34 216.8375     
35 216.8625     
36 216.8875  N 76   
37 216.9125 9125 N 77 C 37 9125 
38 216.9375     
39 216.9625  N 79 C 39 9625 
40 216.9875 9875 N 80 C 40 9875 
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LightSPEED LES 360 Systems:                 
Troubleshooting and Maintenance  

Consult the User Manual for additional information on the 
LightSPEED LES 360 system use and maintenance.  

Battery Check 

 Were the batteries charged overnight? (If not, replace with alkaline 
batteries or fully charged 9-volt batteries.) 

 Is the charging LED illuminated red while charging? 

 Are the transmitter and receiver turned OFF while charging? 

 

Speech-to-Text Translation Delay/Translation Inaccuracy 

 Power. Refer to the System Check. 

 Batteries. Check the batteries first.  

 Check battery contacts for correct polarity match.  
 Check to see that the batteries fit snugly against the contact 

points in the battery compartment. 
 Clean battery contacts if necessary. (Use a deoxidizer, such as 

an alcohol wipe, every 2-3 months.) 
 Recheck the operation of the receiver and transmitter using 

fully charged 9-volt batteries. 
 Microphone. Is the microphone cable inserted securely into the 

transmitter? 

 Wiggle the microphone cord while speaking into the 
microphone. If there is inconsistent or intermittent speech-to-
text translation, the problem may be a damaged microphone 
cord. 

 Clean the microphone jack using an alcohol wipe. 
 If available, insert another TK-150 microphone into the 

transmitter and repeat the check described above. 
 Radio Frequency Interference. Switch to the other channel 

frequency to determine if translation inaccuracy may be due to radio 
frequency interference (RFI). If the interference is no longer present, 
RFI was the problem. 

 Confirm that the selected frequency channel is not duplicated 
by another wireless RF system in a nearby location. 

 Continued RFI may require exchanging your LES 360 system 
for one with a different frequency. 
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iCommunicator System Check 

Before using the iCommunicator software program, complete a System 
Check. A System Check should also be performed at any time when 
there are speech/voice translation accuracy problems. 

Checkpoint LES 360 Solution Parrot Bermuda Solution 
System 
Connections 

 Is the receiver connected to the 
computer’s microphone jack via 
the audio connector cord? 

 
 Is the computer plugged into an 
electrical outlet? 

 Is the microphone 
connected to the 
microphone jack of the 
computer? 

 Is the computer plugged 
into an electrical outlet? 

Power  Is the computer powered ON?  
 Is the receiver powered ON?  
 Is the transmitter powered ON? 

 

 Is the computer powered 
ON?  

 Does the green light 
show when you depress 
the button on the front of 
the microphone 
assembly? 

Battery Status  Are the transmitter and receiver 
batteries charged? 

 Laptop (If using battery power, 
monitor battery status by 
clicking on the icon.) 

 Laptop (If using battery 
power, monitor battery 
status by clicking on the 
icon.) 

Receiver and 
Transmitter 
Frequency 
Settings 

 Are the receiver and transmitter 
set to the same frequency 
channel?  

  

 N/A 

Correct 
Microphone 
Placement 

 Is the microphone positioned 
properly (round part of the 
microphone facing the mouth)? 

 Is the microphone 
positioned properly (flat 
side of microphone 
facing the mouth)? 

Mute 
Capabilities 

 Are you using the Mic switch on 
the transmitter and the 
microphone button/status bar on 
the main screen to avoid 
transmitting unwanted verbiage? 

 Are you using the in-line 
mute switch and the 
microphone button/status 
bar on the main screen to 
avoid transmitting 
unwanted verbiage? 

Other 
Programs 

 Make sure there are no other 
programs running on the laptop 
in the background. 

 Make sure there are no 
other programs running 
on the laptop in the 
background. 
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iCommunicator™, V 4.0 
Installation Procedures Summary Guide 
 
Follow the steps below to install the iCommunicator Version 4.0 software. The various 
screens and windows are designated in bold. If you have any questions, additional 
information is available in the Installation Guide. 

 
1. Attach the hardware security key. 
 
2. Turn on your computer.  
 
3. Insert the iCommunicator Setup CD #1 into the CD-ROM drive. 

 Welcome – Click Next. 
 Licensing Agreement – Read the licensing agreement. Click Yes to proceed. 
 Additional Task  – Leave the Install Signing Videos option selected. Click Next.  
 Setup iCommunicator – Installation window appears and the installation begins. 
 Setup Needs the Next Disk – Insert CD #2 when you see this prompt. 

 
4. Insert the iCommunicator Setup CD #2 into the CD-ROM drive. 

 Click OK. 
 When prompted, click Finish to exit the installation setup. 

 
5. Insert the Dragon NaturallySpeaking Professional into the CD-ROM drive. 

 NaturallySpeaking Setup – Click Next. (You may be prompted to restart your 
computer. If prompted, click OK to restart.) 

 Licensing Agreement – Click Yes to proceed. 
 Customer Information – Enter customer name and the serial number of the back of 

the CD envelope. Click Next and then Next again for the default install path. 
 Setup Type – Select option number 3, Custom Installation, and click Next to 

proceed. 
 Select Components – Deselect Text to Speech Files by clicking in the box to the left 

of the option. Make no other changes. Click Next to proceed. 
 Start Copying Files – Click Yes to proceed with the installation. A blue progress bar 

will indicate that program files are being installed. 
 Dragon Systems Product Registration – Choose your desired registration method 

and proceed. 
 InstallShield Wizard Complete – On the InstallShield Wizard Complete, deselect 

Enable QuickStart mode on Windows Startup. Click Finish to complete the setup.  
 Eject the Dragon CD. 

 
6. Connect the microphone. 

 Locate the microphone system provided with your iCommunicator Kit. 
 Follow the setup instructions provided for your system and make the proper 

connections to the microphone input jack on your computer. 
 

7. Launch the iCommunicator program.  
 Double click on the iCommunicator icon on the desktop or go to the Start Menu > 

Programs > iCommunicator to launch the program. 
 When the program starts for the first time, a new speech/voice file must be created 

before you can speak to the computer and have it translate your voice. Refer to 
Module 3 in the Training Manual for guidance in this systematic process. 
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Module 2 
Menus and Windows 
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Module 2 Objectives 

In this module, you will learn the skills necessary for: 

 working with windows 

 working with menus 

 using the Control window 

 using the Text window 

 using the Signing window 

Preview:  Menus and Windows 

The iCommunicator main screen contains three windows in the standard 
viewing mode, each serving a different function. Seven menus appear on 
the menu bar to help you navigate and manage the iCommunicator 
program. Highlight an option, and then click the left mouse button to 
execute it. The Menu and Window Feature, located at the end of Module 
2, is a useful quick reference guide. 

 The File menu manages files.  

 The Views menu controls the Signing and Text windows, color 
themes, and the viewing mode.  

 The Options menu lets you access unique iCommunicator features, 
such as Speak Incoming Words, Set Talking Voice, Edit Quick Say 
Keys, iText tool, and Speech and Voice Recognition training. 

 The Actions menu lets you turn on or change the signing and speaking 
actions that occur in the Text window.  

 The Signing Options menu lets you enable or disable signing, control 
the signing speed, and retrieve a sign using the Word List.  

 The Font menu offers font sizes from 8 through 72.  

 Obtain help by selecting a topic from the Table of Contents or Index, 
or by conducting a search for a specific topic using the Help menu. 

The Control window is the heart of the iCommunicator program. Use its 
menu commands to perform most program operations. The Control 
window also displays the current speaker, a microphone controls, and a 
special text box.  
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The Text window serves different purposes. Primarily, it displays 
translation of incoming speech. As a speaker talks, the speech recognition 
software translates spoken words into written words, which are then 
displayed in the Text window. As the speaker transmits speech to the 
computer, the program uses acoustical, linguistic, and lexical information 
to translate speech to text. When the speaker pauses, the translation 
process occurs. There is no punctuation in the translation. The Text 
window also displays text when a user opens an existing text file. Use it to 
recite words, sign words, or display a word’s definition using the 
electronic dictionary. 

The Signing window translates converted speech into sign and 
fingerspelling videos. As spoken words are recognized and translated, a 
video clip plays in the window, reinforcing the written word and its 
accompanying sign. Similarly, when a text file is opened, iCommunicator 
can display the signing and fingerspelling for specific words, or an entire 
text passage. 

Menus 

The standard mode displays seven menus on menu bar at the top of the 
iCommunicator’s main screen. These pull-down menus let end users and 
speakers navigate the program and execute actions. The custom mode has 
the same options, although organized differently. 

 

To view the menu selections, click a menu name. Move the mouse pointer 
to highlight the item you want, and then click the left mouse button to 
select it. 

Keyboard shortcuts appear to the right of some menu selections. See page 
66 for a complete listing of keyboard shortcuts and hot keys. 

File Menu  

The File Menu offers a variety of options to 
manage files. 
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New (Ctrl + N)  

Use this to clear any text in the Text window or to prepare a new file.  

When you select this option, the iCommunicator program removes the text 
from the window, but does not save it. If you want to save the text in this 
window, you must do so before selecting New. 

Open (Ctrl + O)  

This opens an existing file and displays it in the Text window. It only 
opens files or documents previously saved as text files—for example, .txt 
or .rtf. 

Demonstration: 

1. From the File menu, select Open 

2. Choose iCommunicator text file Teddy Roosevelt or any other text file 
available on the computer. The file loads to the text window. 

3. From the File menu, select New. The Text window clears. 
 

Save (Ctrl + S)  

Use this command to save the contents of the Text window to a file. 

Save As (Ctrl + A)  

Use this command to name and save the contents of the Text window 
under a new file name. 

Establish a strategy for naming and organizing files for easy access. 

Exit   

Use this command to close the iCommunicator program and return to the 
desktop. In the standard viewing mode, you can also click on the X in the 
upper right corner of the main screen to exit the program. In the custom 
viewing mode, you can also exit the program by clicking on the X in the 
upper right hand corner of the control window. 
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Views Menu 

The Views Menu controls the viewing mode, background themes, and the 
Signing and Text windows. The training process described in this manual 
refers to the standard rather than the custom viewing mode. When an end 
user selects a viewing mode, window arrangement, and/or theme, the 
program remembers that choice and the next time the iCommunicator 
program is opened, the previous viewing mode will display. Additional 
information on the custom mode is available at the end of Module 2. The 
custom mode allows the end user to customize the view by moving and 
resizing windows. Consult the Custom Mode Viewing Options iTip on 
page 64 for information about moving and resizing windows. Experiment 
with resizing and repositioning the windows to customize the view. 

Standard Mode 

A check appears next to Standard Mode is Selected when the user is 
viewing in the Standard mode. Click on this option to change to the 
custom viewing mode. 

 

Themes 

Use this to change the border display and color themes for the 
iCommunicator windows. Different color backgrounds and contrasts 
improve on-screen visibility for some individuals and also allow end users 
to personalize the appearance of the iCommunicator program. If Allow 
Themes is deselected, the display will revert to grayscale. The 
iCommunicator program is compatible with the Microsoft Accessibility 
features, which allow additional modifications regarding viewing 
accessibility, such as a high contrast theme. 

Views Menu for the 
standard viewing mode 



iCommunicator Program 
User Training 

40 

Custom Mode 

In the custom viewing mode, the end user can customize by resizing and 
repositioning the windows. Refer to the iTip at the end of this module to 
learn more about customizing the view. 

 

Signing Window (custom mode only) 

Use this to control the Signing window display in the custom viewing 
mode. This is an open/close function. A check mark indicates the window 
is open.  

Text Window (custom mode only) 

Use this to control the Text window display in the custom viewing mode. 
This is an open/close function. A check mark indicates the window is 
open. 

Demonstration: 

1. From the Views menu, select Themes  Allow Themes. 

2. Select other themes to view those available. 
 

Return to Defaults (custom mode only) 

Use this option to return the window arrangement and background theme 
to the manufacturer’s default settings, which are the standard viewing 
mode and the blue theme. Return to Defaults can only be selected from the 
Custom Views Menu. 

                                        

Views Menu for the 
custom viewing mode  
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Options Menu 

The Options Menu allows end users to 
access unique iCommunicator features, 
such as Speak Incoming Words, Set 
Talking Voice, Edit Quick Say Keys, 
and the iText tool. Speakers use the 
Options Menu to access speech and 
voice recognition training. 

Microphone On/Off 

       

Use this option to turn the microphone ON or OFF. The microphone can 
also be turned ON or OFF by clicking the microphone button in the 
Control Window, by toggling the Microphone Status Bar in the Control 
Window, or by using the Control+M hotkey. End users need to monitor 
the microphone status, as the following actions (by design) disable the 
microphone. After any of these actions, the end user must make certain 
that the microphone is turned ON in order to receive speech-to-text 
translation. 
 
 Opening or closing the iCommunicator program 

 Selecting any signing or speaking action 

 Selecting reset 

 Selecting a new file 

 Clicking the Show button 

 Double clicking a word to obtain a sign 

If the microphone is in the ON position, it is temporarily disabled when 
any of the following actions occur. When the action has completed, the 
microphone is returned automatically to the ON position. 
 
 Opening Edit Quick Say Keys 

 Opening the Word List 

 Opening AutoSave 

 Opening Signing from a Password (if signing is locked) 

 Opening Save File As 

 Opening Talking Voices 
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Autosave                                                     

This feature allows the end user to 
select the automatic save option to save 
translated text displayed in the Text 
window. Click inside the box to enable 
Autosave. The Autosave feature can be 
adjusted by to save text every 5 to 60 
minutes. The Autosave feature also 
allows the end user to restore the last 
Autosave by selecting Restore Last 
Autosave. This will overwrite any text 
currently in the Text Window. 

Speak Incoming Words 

This feature converts recognized words to audible, computer-generated 
speech and transmits speech to the end user’s hearing assistive device. 
Connect the end user’s hearing assistive device to the audio Y-cable when 
using the Speak Incoming Words feature. Otherwise, the speaker’s voice 
converts to computer-generated speech that others can hear from the 
computer’s speakers, and this could be disturbing to others nearby. There 
is value in listening to computer-generated speech, in that the dynamic 
range is more restricted than the human voice, and sound patterns are 
predictable. 

Set Talking Voice 

The talking voice speaks translated, incoming words and it verbalizes the 
words found in text documents. It also gives intelligible speech to users 
who need this type of assistance for voice output. To make a comment, 
ask a question, or to reply, simply type the words into the Say This/Note 
This text box. Press Enter and the computer speaks the words that appear 
in the text box.  

The Set Talking Voice 
command opens a dialog 
box that lets end users 
choose options to 
customize the computer-
generated voice.  
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A male or female voice may be selected. The parameters of pitch and rate 
(speed) may be manipulated. Then listen to your selections, and Accept or 
Discard the changes by selecting the appropriate button. Adjust the rate of 
speed to help users hear multi-syllable words, such as Constantinople. Use 
this feature to improve speech recognition and speech intelligibility skills. 

Demonstration 

1. Choose a male or female voice.  

2. Click the down arrow to view a list of talking voice options.  

3. Click and highlight to choose a talking voice. 

4. Click Test to hear the talking voice. 
 

Pitch and Rate 
Use these features to manipulate the pitch and rate (speed) of the 
computer-generated voice.  

Demonstration 

1. Move the sliders to change the pitch and rate. 

2. Click Test to hear the pitch and rate variations. 

 

Edit Quick Say Keys 
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This feature lets end users create and edit the Quick Say messages 
assigned to the function keys. The iCommunicator program can store up to 
22 Quick Say messages (two text boxes are reserved for system use). 
Enable the second set of twelve text boxes by clicking inside the Show 
Shift + Function Key box. Enter up to 256 characters (including spaces) in 
each text box. 

The computer delivers these comments, questions, and ideas when you 
press the appropriate Quick Say function key. This end user feature can be 
useful for medical appointments, interviews, or other instances where the 
end user wants to prepare responses or important information in advance 
and not be concerned about spending time during an interchange to type 
the messages. 

Demonstration  

1. From the Control window’s Options menu, select Edit Quick Say 
Keys. 

2. Edit the text in the F12 Quick Say text box.  

3. Choose Save to store your Quick Say message.  

4. Choose Exit to close the window and return to your iCommunicator 
window.  

5. Press F12+Enter to hear the computer speak the corresponding text.  
 

Clear Text Window When Starting 

When you select this feature, an empty Text window displays each time 
you turn on the iCommunicator program. 

Start With Windows 

Select this feature to have the iCommunicator program open automatically 
when you start your computer. 

Signing Locked 

When the end user prefers not to use 
the signing feature, the Signing 
Window may be disabled or locked. 
The process uses password protection. 
The lock feature is available only g in 
the Custom viewing mode. When this 
feature is selected, all commands for 
the signing option disappear from the Options Menu in the 

Custom Viewing Mode 
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iCommunicator program menus. A check mark appears on the Options 
menu to indicate that signing is locked. A user cannot unlock and enable 
signing without the correct password. 

Demonstration 
To lock or unlock the Signing window: 

1. Switch to the custom mode. From the Views menu, deselect Standard 
Mode is Selected.  

2. From the Options menu, choose Signing Locked. The password 
window appears. 

3. Enter a password in the Password window text box. 

 
Note: defaultpassword is 

the password when the 
iCommunicator program 
ships from the manufacturer. 
You must type 
defaultpassword in the text 
box before attempting to 
lock signing or change the password.  
 

4. Choose the Enter button to enter a password, the Change button to 
change your password, or the cancel button to close the password 
window without changes. Follow the instructions on your screen. 
Remember the password you select. You will need it to unlock the 
signing feature. 

 

iText Tool 

Use the iText tool to have documents, email, and web pages signed and/or 
spoken through the iCommunicator program. iText captures text from web 
pages, email, word processing documents, and other software applications 
and immediately displays it in the iCommunicator Text window. Pre-
select the action (i.e., signing, speaking, signing and speaking) and the 
pause time before the action initiates. Then, simply point and click on the 
iText button in your computer’s Systray to initiate the desired action. The 
iCommunicator program will remember your settings when you close the 
program. The iText feature is only available in the Standard viewing 
mode. 
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Demonstration 
Follow these directions to use iText. 

1. Open the iCommunicator program.  
a. The iText button will display in your computer’s Systray. 
b. From the Options menu, select iText  Default Left Click Action. 

Click on the desired action. 
 

 
 

c. From the Options menu, select iText   Pause Before Action. 
Select the delay time before the action starts in the Text window. 

 

 
 

2. Select and open a document in another application, such as Word, 
Excel, PowerPoint, an email message, or a web page. Place the cursor 
in the text. 

 
3. To capture all of the text in the document: 

a. Click on the iText button in the Systray.  
b. Text will display in the 

iCommunicator Text window and 
the chosen action will begin. 

 
4. To capture selected text in the 

document: 
a. Highlight the text you wish to 

have signed and/or spoken. 
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b. Right click on the iText button in the Systray. A pop-up menu 
displays. 

c. Left click on the desired action for the selected text (i.e., sign, 
speak, sign and speak). 

d. Selected text will appear in the iCommunicator text window. Text 
will be signed and/or spoken according to the action from the pop-
up menu. 

 

Speech Recognition    

 

Speakers use these menu options to create a new user, save speech files, 
run General Training, run Audio Wizard, and run the Vocabulary Builder 
and Vocabulary Editor. Each activity is part of the speech/voice 
recognition training process. These options are described in Modules 3 
and 4. You will work with these features during speech and voice 
recognition training. 

Change Current Speaker 

 

        Options Menu in the                     
          Standard Viewing Mode 
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The iCommunicator program performs speech-to-text translation when a 
speaker has his/her own speech/voice file selected. From the Options 
Menu, select Speech Recognition ► Change Current Speaker. Select the 
speaker’s name from the list. You will see the message, “Changing active 
speech files. Please wait.” It also is possible to change the current speaker 
by clicking on the current speaker’s name at the bottom of the Control 
Window, and then selecting the desired speaker’s name from the list. 

Delete Speaker  

If you are certain that you no longer need a speaker’s speech/voice file, 
you can delete it. Once you delete a speaker’s S/V file, it is gone forever. 
Make sure you do not need it before you remove it.  

You may wish to archive the speaker’s 
S/V file for use at a later time. In this 
instance, transfer the S/V file to a zip disk, 
CD, or LAN. Always use the Delete 
Speaker menu selection to delete speaker 
files. Delete Speaker is the only way to 
properly remove all information about a 
user. Before deleting the current speaker, 
close that speaker’s S/V file by opening 
another speaker’s file, then select Delete 
Speaker. The important point to remember 

is that you cannot delete the current 
speaker easily. 

Demonstration 
To delete a speaker’s S/V file: 

1. From the Options menu, select Speech Recognition ► Delete Speaker 

2. From the Speaker list box, select the name you want to remove.  

3. Click Delete and answer Yes to the prompt confirming that you wish 
to delete the speaker. 

4. When the Done window appears, click OK. 
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Show Results Box 

The Show Results Box is a small, floating text box that displays the results 
of the speech/voice analysis as it occurs. When the red square appears in 
the upper left hand corner of the text box, this indicates that speech 
recognition is occurring. The Show Results Box functions somewhat like a 
notepad, where you jot down ideas, and later formulate the precise 
sentence you wish to write.  

 

It is not uncommon for words in the Show Results Box to change while a 
speaker is talking. This occurs because the speech recognition engine is 
taking time to make decisions about which words to translate. It does this 
by considering contextual and speech model information (i.e., acoustical, 
lexical, linguistic) to select the appropriate word choice for translation. 
Sometimes the program has to hear a word in a phrase or sentence before 
it actually recognizes the word.  

Some users prefer displaying the Show Results box along with the other 
iCommunicator features, because it gives them the opportunity to view 
speech-to-text translation almost immediately. Experiment in using this 
feature when you speak to the computer later in the training process. 

Change Font Size and Color 
The default font size in the Show Results Box is 8; however, end users can 
change the font size to a maximum of 24. In addition, the font color can be 
changed. The following procedure is based upon the Windows XP 
operating system (OS). If your computer has an earlier operating system, 
consult the system’s Help File for information on locating the path to the 
ToolTip.  

 
Follow these steps to change the font size and color: Start ► Control 
Panel ►Appearance and Themes ► Display ► Appearance ► Advanced 
► ToolTip. At this point you will be able to change the color and size of 
the font that will display in the Show Results Box. If you change the font 
size or color in the ToolTip, those changes will be effective for the entire 
operating system. 

 

the show results box is a helpful tool because it displays translated 
text almost immediately although some of the words may not appear 
in the text window because the system is using contextual information 
to determine the most appropriate words it also is helpful when the 
speaker talks a long time before taking a pause 
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Change Position of the Show Results Box 
To prevent the Show Results Box from moving on the iCommunicator 
main screen, use the mouse to click and drag the text box to the desired 
position on the screen. Then right-click the Results box, and select 
Anchor. The Show Results Box will remain anchored in that location. 

Actions Menu 

 

The Actions Menu lets you turn on or change the signing and speaking 
actions that occur in the Text sindow. To choose the starting point for an 
action, place the cursor in the text box and click where you want the action 
to begin before selecting the Actions menu command. The Actions menu 
commands Reset and Pause also appear on the top border of the Text 
Window for easy access. Simply click to use the Action command. The 
button on the Text Window changes from “Pause” to “Continue”. Click 
Continue to restart the action. 

Reset 

Use Reset to halt the computer-generated speech, turn off signing, and 
reset the microphone. Access this command from the Actions menu or the 
button on the Text Window. 

Pause 

Use this feature to temporarily halt the action in the Text or Signing 
windows, or to stop delivery of computer-generated speech. Click 
Continue to restart the halted action. Access this command from the 
Action menu or the Text Window. 

Sign Text Window 

Select Sign Text Window to have the iCommunicator program sign the 
words in the Text window without generating a voice. From the Signing 
Options menu, select the signing speed for comfortable viewing. 

Pause button changes to Continue 
until the action is restarted. 
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Speak Text Window 

Select this action to convert the words in the Text window to audible 
computer-generated speech. The computer-generated speech can then be 
delivered through the computer’s speakers, or sent to the end user’s 
hearing assistive device via the Audio Y-cable. 

Sign and Speak Text Window 

This action simultaneously signs the words in the Text window and 
generates audible computer-generated voice. 

Signing Options Menu  

 

 

 

 

 

 

The Signing Options Menu lets you enable or disable signing, change the 
signing speed, and find the sign for a word by accessing the Word List.  

Enable or disable signing by clicking Enable Signing, or by using the 
shortcut Control+Enter.  

Select a comfortable signing speed, ranging from slowest to fastest. Most 
end users who use sign language choose a speed of 4 or 5. In Version 4.0, 
the signing speeds have been readjusted so that the slowest speed 
represents the actual film speed of the sign video. Individuals who wish to 
learn fundamental sign language may choose the slowest speed. 

Select Word List to view an alphabetical display of words in the signing 
video library. Choose a word from the drop-down list, and then click the 
check mark to view the accompanying signing video. 

Scroll to find a word, then click 
the check mark to view the sign. 
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Font Menu 

Select the font size for comfortable on-screen viewing. Font 
sizes are available from 8 through 72. 

The electronic dictionary operates most efficiently with the 
font size 16 or 18. 

Demonstration: 

1. From the File menu, choose Open, and then select Teddy 
Roosevelt. Text displays in the Text window.  

2. From the Font menu, select different font sizes for comfortable 
viewing. 

3. From the Actions menu, choose Sign Text Window. 

4. Press Control+P to halt signing. Press Control+P again to resume 
signing. 

5. Place the cursor next to any word in the Text window to begin signing. 
This also applies to the Speak Text Window function. 

6. From the Signing Options menu, make selections to manipulate the 
signing speed, and enable/disable signing. 

7. From the Actions menu, select Sign and Speak Text Window. 

8. From the Actions menu, select Speak Text Window. 

9. Press Control+R to turn off the speaking action. 

10. From the Signing Options menu, select Word List. Select a letter from 
the pull down menu and then select a word. Click on the check mark 
and to see the accompanying sign display. 

 

Help Menu  

The iCommunicator program provides a 
comprehensive help system. Although the 
iCommunicator windows, menus, and features are 
easy to use, you may occasionally need help. If you 
are unable to find the information you need, contact 
Customer Service at (800-245-2133) for assistance. 
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Contents 

When you select Contents, the 
iCommunicator Help System opens 
with the Table of Contents tab 
active. The left pane of the Help 
window displays the system 
hierarchy from which you can select 
a topic. The right pane displays the 
selected topic explanation. Use the 
Contents, Search, or Index tabs to 
find additional information to assist 
you. The Search tab lets you locate 
help by performing a key word 
search. Use the Index tab to select a 
help topic from an alphabetical list.  

Hot Keys 

This option displays a list of iCommunicator program hot keys and their 
function. Hot keys can be used to quickly execute iCommunicator menu 
commands by using keyboard combinations. The list of hot keys can be 
accessed with the Control+H keyboard command. A listing of the hot keys 
is available on page 66. 

About 

About displays license information about the iCommunicator program, 
such as the version and build numbers, serial number, and other program 
information. You will need this information if you contact Customer 
Service for support. 

Windows  

The iCommunicator program contains three windows – the Control 
window, the Text window, and the Signing window. All display on the 
iCommunicator’s main screen. 
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The standard window display is used for training purposes. Refer to the 
Custom Mode Viewing Options iTip on page 64 for information about 
customizing the window arrangement and minimizing and restoring the 
iCommunicator windows. 

Control Window  

The Control window lets you to manage the program’s functions. The 
Control window has four components: 

1. Say This/Note This text box 

2. Current Speaker indicator 

3. Microphone Status Bar 

4. Microphone ON/OFF Button 

 

 

 
 
 
 
 
 
 
 

Control 
Window

Signing 
Window

Text 
Window

List of Speakers 

Control 
Window 

 Current Speaker 
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The Control window features, combined with the menus, let you manage 
how the program functions. Do not close the Control window until you are 
ready to stop using the iCommunicator application. Closing the Control 
window exits the iCommunicator program. 

Select the Current Speaker 

Use this feature to change the speaker you want the iCommunicator 
program to recognize. After a speaker completes initial speech/voice 
recognition training, their file name appears on the list of Current 
Speakers. You must tell the iCommunicator program which speech/voice 
file to use. It is important to only use your own speech/voice file to ensure 
translation accuracy. To view the list of speakers who have speech/voice 
recognition files, simply click on the Current Speaker indicator. Select a 
speaker from the drop down list. 

A message box displays when changing 
speaker files. It takes less than a minute for the 
program to change from one speaker to the 
next. When the new speaker’s name appears, 
the program is ready to receive the speaker’s 
speech. 

Demonstration:  
 Click on the Current Speaker indicator to display a list of speaker’s 

speech/voice recognition files recognized by the program. 

 Select a different speaker’s file, if other files exist on your computer. 

 

Say This/Note This Text Box 

This unique feature lets the user enter text that the computer speaks. It also 
inserts notes or comments in the Text window. This feature is helpful for 
taking notes during a lecture, or to display two-way conversation. 

Say This   
The computer converts the words typed in the text box to computer-
generated speech. You can choose to deliver computer-generated speech 
to the computer’s speakers, the external speakers, or to an individual’s 
personal assistive hearing device using the audio Y-cable. 

As iCommunicator speaks the contents of the Say 
This text box, the microphone status area changes 
to a colored speaking indicator. This lets users 
who are deaf or hard of hearing know when iCommunicator is finished 
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speaking. When transmission is complete, the speaking status bar 
disappears. 

Demonstration: 

1. Type a statement into the text box.  

2. Press enter. The computer-generated voice delivers the text. 

 
 
 
 
Note This  
Add notes to the Text window by 
typing in the Say This/ Note This text 
box and then pressing Control+Enter. 
The text appears in the Text window, 
enclosed with arrows. If you choose 
not to type, use Control+Enter to place 
the arrows in the text box. For example, use the double arrows to indicate 
important information.  

The last 10 entries placed in the Say This/Note This text box can be 
displayed by clicking the down arrow on the right hand side of the text 
box. This is useful if the end user wishes to repeat a comment. The Note 
This function does not generate voice output. 

 
 
 
Demonstration:  

1. Type some text in the Note This/Say This text box. 

2. Press Control+Enter. The text appears in the Text window enclosed by 
arrows. 

3. Press Control+Enter. The two arrows appear in the Text window and 
serve as a notation. 

4. To display the last ten entries, place your cursor on the arrow to the 
right of the text box. Highlight a selection and it will appear in the text 
box. 

Pull-down window displays the last 10 entries. 
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Microphone Status Bar 

The microphone status bar displays a 
graphic indicator of the microphone input. 
Color appears over the background to 
indicate the status. 

 
Color Status 
amber  on and ready to receive speech 

 listening, but not detecting any sounds it considers to be 
speech 

green  in use and receiving speech 
red  audio level is too high  

 can occur if speaking voice is louder than the 
presentation voice used during speech/voice training 

 need to rerun Audio Wizard 
black  microphone is OFF 

 
Demonstration 
Use the microphone status bar to turn the microphone OFF and ON. 

1. Move the mouse pointer directly over the microphone status bar and 
click it once to turn off the microphone. 

2. Click it again to turn on the microphone. The default is the ON 
position. 

3. If the Microphone Status Bar turns red while speaking into the 
microphone, the audio level is too high. You must run the Audio 
Wizard and recalibrate the microphone. If the redlining continues, 
further troubleshooting and adjustment may be necessary. Contact 
Customer Service for assistance. 

Microphone ON/OFF Button 

Click this button to turn the microphone 
ON or OFF. For more information about 
the functions of the Microphone ON/OFF 
button, refer to page 41. 

Demonstration:  
 Experiment with turning the microphone ON and OFF by toggling the 

Microphone Status Bar and by using the Microphone button. Use this 
feature during speech/voice recognition training and vocabulary 
building. 
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Text Window  

Speech converts to text and displays in the Text window. When the Text 
window is closed, the program continues to translate and add text. The 
translated text appears in the Text window when it reopens. 

General Features of Text Window 

Speech to text conversion occurs when the speaker pauses or takes a 
breath. Text wraps onscreen when the speaker pauses. A slight delay in the 
text display occurs as the program compares what the speaker says with its 
internal speech/voice model. The program uses acoustical, lexical, and 
linguistic information, as well as context clues to translate speech to text. 

The Show Results Box offers a direct way to view translated text before it 
appears in the Text window. This small box resembles a tool tip. The 
Show Results Box is helpful when the speaker infrequently pauses during 
delivery. To activate the Show Results Box, select Speech Recognition  
Show Results Box from the Options menu. 

 

 

 

 

 

 

 

You can enter keyboarded text directly into the text window, or use the 
Say This/Note This feature.  

From the Actions menu, you can choose to have the iCommunicator 
program sign, speak, or simultaneously speak and sign text that displays in 
the Text window. Three actions (i.e., Reset, Pause, Show) may be 
activated easily by clicking the appropriate button on the border of the 
Text window. These actions also may be initiated by using the Actions 
menu.  
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Change the Font   

Use the Font menu to change the font size. Click on the Font menu, and 
then select a font size that allows for comfortable viewing of the computer 
screen. 

Save the Text Window Contents  

Use this option to save the contents of the Text window for later use. The 
program saves the text in Rich Text Format (.rtf).  

 

 
 
Demonstration:  

1. Type a few sentences in the Text window. 

2. From the File menu, select Save As (The Save As window appears.) 

3. Type a name for your file in the file name text box. 

4. Click Save. 

5. From the File menu, select Open, and select your File’s Name (Note 
that it has been saved in Rich Text Format [.rtf].) 

6. Click Cancel. 
 

Clearing the Text Window 

To clear text that appears in the Text window: 

Demonstration: 

1. From the Control window File menu, select New 

Rich Text 
Format (.rtf)
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2. Choose Yes to remove the text from the window. 

 

Use the Clear Text When Starting option when you want a clear Text 
window each time you open the iCommunicator program. 

 From the Options menu, select Clear Text Window When Starting. 

 

Closing and Opening the Text Window 

Demonstration 
 

Open the Text Window 

 From the Control window Views menu, select Text Window. 

A check mark appears on the menu, indicating the option is enabled. 

Close the Text Window 

Do one of the following: 

 From the Views menu, deselect Text Window. 

 Click the X in the upper right corner of the Text window. (Custom  
mode only)  

Changing the Windows Theme 

Choose from several preprogrammed themes to change the background 
color theme of the iCommunicator windows. The program remembers 
your theme each time you make a change. 

Demonstration 

1. From the Views menu, select Allow Themes. 

2. A check mark appears on the menu, indicating this option is on. 

3. Click on a theme name to select a theme. 

4. To deselect themes, click on Allow Themes again. 

5. The check mark disappears from the menu, indicating the option is off. 
 

Resize the Text Window 

This option is available in the custom mode only. Refer to the Custom 
Mode Viewing Options iTip on page 64 for further information. 
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Using the Electronic Dictionary within the Text Window 

The iCommunicator program’s electronic dictionary provides end users 
with a valuable literacy tool. The electronic dictionary gives an immediate 
definition for a selected word in the Text window. Owners can take 
advantage of the free registration at www.babylon.com to receive 
notification of downloadable electronic dictionary updates. The electronic 
dictionary is also accessible when using a word processing program. 

 
 
Demonstration 

1. Place the cursor on a word in the Text window, and then press 
Shift+Right Click (right mouse button). The definition displays.  

2. Click the Say button, and the computer pronounces the word.  

3. Click on another word in the definition. The electronic dictionary then 
displays the definition for the new word. 

 

Retrieving a Sign for a Word in the Text Window  

There are two ways to retrieve a sign for a 
word displayed in the Text window. Place the 
cursor on a word, such as numerous. If the sign 
is not in the video sign language dictionary, 
the program fingerspells the word. 

1. Double click on the word with the left 
mouse. In this example, double clicking the 
word numerous produced the sign. 

2. Click the Show button on the Text window 
border. The sign for the word displays in 
the Signing window. 
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Demonstration: 

1. From the File menu, select Open, and then choose Ancient History. 

2. Place the cursor on a word. 

3. Press Shift+Right Click. The definition displays. 

4. Click on the Say icon to hear the word spoken. 

5. Click another word in the definition to see its definition display. 

6. Place the cursor on another word. 

7. Double click on the word. (The sign will display.) 

 

Signing Window 

The Signing window displays sign language and fingerspelling videos. 
The program contains more than 9,200 video clips of individually signed 
words and fingerspelling videos. If there is a sign video in the library, it 
displays; otherwise, the word is fingerspelled. When several persons are 
viewing the screen, enlarging the Signing window in the Custom viewing 
mode may be helpful. Image clarity changes with enlargement. Use 
magnifier buttons at the top of the Signing window to increase or decrease 
the size of the Signing window.  

Use the Signing Options menu to control the signing functions. Select 
Enable Signing to turn on signing. A check mark appears beside the menu 
option. The signing speed can be controlled from this menu. Turn off 
signing by selecting Enable Signing again, and the check mark will 
disappear. A sign can also be accessed for a word in the Text window by 
clicking the Show button on the Text window. Another option for 
obtaining a sign is to use the Word List from the Signing Options menu. 
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Module 2 Review 

True or False 
 
____ 1. You should not close the Control window until you are ready to stop using 

iCommunicator program. 
 

  
____ 2. To return windows to their default configuration, select the Return to Defaults 

command. 
 

  
____ 3. Translated speech does not continue to add to the Text window when the 

window is closed. 
 
 

  
____ 4. Selecting a different theme can improve on-screen visibility. 

 
 

  
____ 5. A black Microphone Status Bar indicates that the transmitter is OFF. 

 
 
 

Multiple Choice 
6. There is nothing displaying in the Signing window. What do you do to investigate the 

problem? 
a. Select the Options menu in the Signing window and see if Enable Signing 

command is selected or not. 
b. Click the Options menu in the Control window to see if signing is locked. 
c. Close down the program and open it again. 
d. Both a. and b. 
 

7. The Signing Locked command  
a. sets the speed at which sign language and fingerspelling are displayed. 
b. is password protected. 
c. removes all references to signing in the iCommunicator. 
d. Both b. and c. 

 
Check your answers using the Answer Key in the back. 
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Custom Mode Viewing Options 

 
 

The Custom viewing mode is accessed from the Views menu. In the 
Custom mode, the end user has the opportunity to customize the 
appearance of the iCommunicator windows by moving, closing, and 
resizing the windows to meet individual viewing needs and preferences. 
This virtual docking feature allows the end user to use the right mouse and 
move all of the windows as one unit. 

Key Differences from the Standard Mode 

The Font menu moved from the menu bar to the Text window and the 
Signing Options menu moved from the menu bar to the Signing window. 

You can resize and reposition windows.  

Moving the Windows 

Demonstration 

1. Move your mouse pointer over the window you want to move. 

2. Hold down the left mouse button and drag to the window.  

3. Click and hold down the left mouse button and drag the window to the 
desired location. 

4. Release the mouse button. 
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Minimizing and Restoring Windows in the Custom Mode  

Close windows by clicking on the “X” in the upper, right-hand corner of 
the window. 

Icons in the upper-right corner of the Control window provide a quick and 
easy way to minimize, restore, resize, and exit the iCommunicator 
program.  

Use To 
 Reduce (minimize) the iCommunicator program to a button on 

the task bar. Click the taskbar button to open iCommunicator 
again. 

▼ Decrease the Control window size. 
▲ Increase the Control window Size. 
X Exit the iCommunicator program and return to your desktop. 

 

Use the magnifiers on the Signing window to increase or decrease the size 
of the Signing window. There are three sizes available. 

You must be using the custom mode in order to resize the Text window.  

Demonstration 

1. Move the mouse pointer to the window’s edge at any of the four sides.  

2. When the double arrow appears, hold down the left mouse button and 
drag to the desired size.  

3. Release the mouse button when the desired size appears. 
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Keyboard Shortcuts and Hotkeys 

You can quickly execute iCommunicator menu commands using keyboard 
combinations, called hot keys. The hot key combination displays on the 
pull-down menu along with the command. Hold down the first key (e.g., 
Ctrl or Alt), and then press the key shown with it to use the shortcut. In the 
Standard mode, all menus display the hot keys. 

Hot Key 
Combination 

Menu iCommunicator Menu 
Command 

Ctrl+A File Save As 

Ctrl+B Actions Sign and Speak Text window 

Ctrl+D View Return to Defaults 

Ctrl+E Options Enable Signing 

Ctrl+G Actions Sign Text window 

Ctrl+I Options Speak Incoming Words 

Ctrl+K Actions Speak Text window 

Ctrl+N File New 

Ctrl+O File Open 

Ctrl+P Actions Pause 

Ctrl+R Actions Reset 

Ctrl+S File Save 

Ctrl+W Actions Word List 

Ctrl+Enter N/A Place Note This text in Text 
Window 
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iCommunicator Menu and Window  
Feature and Function Guide 

 
MENU  FUNCTION 
File Menu Manages files 

• New Clear text in Text window or prepare new file 
• Open Open existing file and place in Text window 
• Save Save contents of Text window; saves in Rich Text Format (.rtf) 
• Save As Save contents of Text window under a different file name 
• Exit Close iCommunicator program (or click X in upper right corner of main screen) 

Views Menu Controls Signing and Text windows, color themes, and viewing mode 
• Standard Mode Default window configuration is the standard mode; windows stationary 

• Themes Allow themes; change border display and background color theme for personalized 
and comfortable viewing; default theme is blue 

• Standard Mode is 
Selected 

Select Standard Mode is Selected to remain in the Standard viewing mode 

• Custom Mode Deselect Standard Mode is Selected; customize window arrangement/size 
• Signing Window Select or deselect to open or close the Signing window 
• Text Window Select or deselect to open or close the Text window. 
• Themes See Themes under Standard Mode. 
• Change to Standard 

Mode 
Select to return to the Standard viewing mode 

• Return to defaults Returns window configuration to Standard and theme to blue 
Options Menu Unique end user features and speech/voice recognition training 

• Microphone ON/OFF Select to turn microphone ON/OFF 
• Autosave Enable to Autosave contents of Text window @ 5-60 min. intervals 
• Speak Incoming Words Convert speech to computer-generated voice and  deliver to peripheral assistive 

hearing device via audio Y-cable 
• Set Talking Voice Personalize the computer talking voice by selecting gender, pitch, and rate 
• Edit Quick Say Keys Assign messages to 22 text boxes; press appropriate function key to  initiate 

delivery by computer-generated voice 
• Clear Text Window When 

Starting 
Select to display an empty Text window when starting iCommunicator program. 

• Start with Windows Select to have iCommunicator open automatically when starting computer 
• Signing Locked Accessible only from the Custom mode; disable signing using a password. 
• Speech Recognition Opens another menu panel with features used to create, build, save, and manage a 

speech/voice recognition file 
• Change Current Speaker Select S/V file from menu or select from Current Speaker pull down list on Control 

Window. 
• Save Speech Files Select to save changes to S/V file; red warning screen appears. 
• Show Results Box Floating text box that displays speech-to-text during analysis process. 
• Create New Speaker Initiates process of creating a new speaker S/V file 
• Run Audio Wizard Calibrate microphone. 
• Run General Training Select stories to read to build S/V file. 
• Delete Speaker Select S/V file to be deleted; confirmation screen appears. 
• Vocabulary Builder Processes to fine tune a speaker’s S/V file. 
o Vocabulary Editor Add, train, or delete words or phrases in the program’s vocabulary. 
o Vocabulary Builder Analyze documents and train unfamiliar words. 

• iText Displays email, web pages, and other documents in Text window for information to 
be signed, spoken, or signed and spoken 

o Default Left Click 
Action 

Choose sign, speak, or sign and speak as the desired action 

o Pause Before Action Choose either a 3 or 5 second pause before the action begins in the Text window 
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MENU  FUNCTION 
Actions Menu Initiate or change signing and speaking actions in the Text window. 

• Reset Halt computer-generated speech, turn off signing, reset the microphone, and other 
actions; also initiate action from Text window border. 

• Pause Temporarily halt action in Text or Signing windows; also initiate from button on Text 
window border. 

• Sign Text Window Place cursor and the text is signed. 
• Speak Text Window Place cursor and the text is spoken. 
• Sign and Speak Text 

Window 
Place cursor and the text is simultaneously signed and spoken. 

Signing Options Menu Enable signing, select a sign using the word list, and control the signing 
speed. 

• Enable/disable signing Select or deselect to enable or disable signing. 
• Select signing speed Select a comfortable signing speed to match the end user’s proficiency level, from 

slowest to fastest; 5 is the speed most users prefer. 
• Word List Select and then scroll to find the word for a sign; click the check and the sign displays. 

Font Menu Change the font size for comfortable viewing. 
Help Menu Use to find information about the iCommunicator program features and 

functions. 
• Contents Displays contents of the Help files. 
• Hot Keys Displays list of keyboard shortcuts. 
• About Provides licensing information about the iCommunicator program you own. 

 
WINDOW  FUNCTION 
Control Window Controls the microphone, lists current speakers, and the Say This/Note This 

text box. 
• Current Speaker 

Indicator 
Displays name of current speaker; pull down list displays names of all speakers with S/V 
files recognized by the program. 

• Say This/Note This Type text in the text box and the computer speaks it (Enter) or displays it in the text box 
enclosed with < > symbols (Control+Enter) 

• Microphone 
ON/OFF 

Click the button to turn onscreen microphone on or off. 

• Microphone Status 
Bar 

Toggle over the bar to turn the microphone on or off; color indicator displays the status of 
speech input. 

Text Window Displays speech converted to text or an existing document file. 
• Reset Button Same as Actions Menu. 
• Pause Button Same as Actions Menu; changes to Continue until Pause is selected again to resume the 

action. 
• Show Button Place cursor on a word, click Show button, and sign displays 
• Obtain Definition Place cursor on a word, then Shift+Right Click, and definition displays; click Say to hear 

pronunciation. 
• Retrieve Sign Double click on a word and the sign displays. 

Signing Window  
• Display Signs More than 9000 sign and fingerspelling videos display in the Signing window. 
• Resize Window In the custom viewing mode, Signing window can be resized. 
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Module 3 
Speech and Voice Recognition Training 



iCommunicator Program 
User Training 

70 

Module 3 Objectives 

In this module, you will learn the skills necessary for: 

 using the New User Wizard 

 creating a Speech/Voice Recognition file 

 calibrating the microphone 

 initial speech/voice training 

Preview: Speech and Voice Recognition Training 

When the iCommunicator Version 4.0 software installation is completed, a 
speech and voice (S/V) recognition file must be created before anyone can 
speak into the microphone and have their speech translated to text. 
Creating a new user is a simple and systematic process. You must provide 
the computer your name and the speech and vocabulary models needed for 
iCommunicator. You will train the computer to recognize your unique 
speech and voice patterns.  

Initial S/V training is not difficult, taking only about 10 minutes to 
calibrate your microphone and read aloud a short selection. To assist you, 
the iCommunicator software program provides an easy-to-use interface 
called the New User Wizard. You will read a short, instructive selection 
entitled “Talking to Your Computer.”  

When you complete the initial training, you are invited to have the 
program analyze documents to adapt to your writing style. If a speaker 
does not have files on the computer, it is recommended that the speaker 
load available technical documents, vocabulary lists, or other documents 
so that the program can analyze the documents. It takes only a few 
minutes and it does increase translation accuracy. Load these electronic 
files before you begin to create your speech/voice recognition file. The 
program has the capability to analyze documents created in the following 
programs or naming conventions: Microsoft Word, Word Perfect, Text, 
and Rich Text Files. 

Complete an Accuracy Check following the initial training, using a 
prescribed protocol. (Refer to Appendix B to locate the Accuracy Check.) 
If your accuracy is 90% or better, it will not be necessary to complete a 
second reading. Proceed to Vocabulary Building in Module 4. 
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If the Accuracy Check shows that your accuracy needs improvement, read 
one more short selection. From the Options menu, choose Speech 
Recognition  Run General Training. The selections available in this 
section take about ten minutes to read. This evaluates how well the 
iCommunicator program is translating your speech. When you achieve 
90% or better accuracy, you can proceed to Vocabulary Building.  

Environmental factors and the condition of your voice can significantly 
influence speech and voice recognition training. Whenever possible, create 
speaker files and complete initial voice training in the environment in 
which you plan to use iCommunicator. If training occurs in a different 
environment, you will need to rerun Audio Wizard when you use the 
iCommunicator in the classroom or in the workplace. This will calibrate 
the microphone. You do not have to rerun Audio Wizard daily – only if 
there is a condition that indicates the needs to repeat the process. 

Since your speaking voice may differ greatly from your reading voice, it is 
important that you perform speech and voice training in the same voice 
and with the same vocal effort that you plan to use with the 
iCommunicator program in your workplace or other special application 
environment. Rerun the Audio Wizard any time conditions change, such 
as the acoustical environment, voice change due to a cold, translation 
accuracy is degraded, or when a different microphone or sound card is 
used.  

Dictation tips included in this module will assist speakers in mastering the 
speech and voice recognition training process. Follow the basic guidelines 
in this module to establish your speech/voice recognition file and achieve 
accurate speech translation. 

Speech and Voice Recognition Training 

System Check  
Refer to the System Check on page 33. 
 
Check the following key points: 
 
 system connections (power, audio connector cord, and microphone) 
 power (computer, receiver, and transmitter) 
 battery status (computer, receiver, and transmitter) 
 receiver and transmitter frequency and channel settings 
 correct microphone placement 
 mute switch 
 close all other programs when using the iCommunicator program 
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Overview of Continuous Speech Recognition  

The iCommunicator program uses continuous recognition of natural 
speech to translate what a speaker is saying into text and/or sign in real 
time. Dragon NaturallySpeaking Professional is the speech 
recognition engine that underlies the iCommunicator Version 4.0 software 
program. The speech recognition engine tries to match the speaker’s oral 
speech and language patterns with its own built-in oral speech and 
language model. The speech recognition engine relies on three information 
sources to achieve translation accuracy. 

 Acoustic – what a typical voice sounds like  

 The speech recognition engine creates a mathematical model of 
the sound patterns used by each speaker. 

 Linguistic – how a typical person puts words together  

 The speech recognition engine compiles statistical information 
associated with a vocabulary that describes the likelihood of 
words and sequences of words occurring in the speaker’s 
language model. 

 Lexical – a typical English vocabulary 

 The speech recognition engine recognizes thousands of words 
that are in its built-in lexicon, and each word in the vocabulary 
has both a text representation and a pronunciation. 

When you Create a New User, you begin with a standard set of acoustic, 
linguistic, and lexical models. As you read selections, and later speak 
spontaneously into the computer, you customize these models for the 
manner in which you speak (acoustical model) and the way you use words 
(linguistic and lexical models). When the speech recognition program 
learns about your speech and voice characteristics, it will become more 
accurate in its translations. The speech recognition engine uses your 
customized speech/voice recognition file to predict the words you have 
spoken. 

When you initially use the iCommunicator software program, you will 
notice some translation inaccuracies. Use Vocabulary Builder and 
Vocabulary Editor to customize and expand the lexical model. Add 
technical terms and vocabulary you routinely use by speaking or by 
analyzing documents, and then training any unfamiliar words that the 
iCommunicator program does not recognize. 
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You can enhance the linguistic model to better match your spoken 
language patterns by speaking to the computer and saving small segments 
of correctly translated speech. Another effective way to improve the 
linguistic model is to analyze existing documents, such as lecture material 
or reference documents, under the speaker’s speech/voice recognition file. 
This process is very quick and the speaker then has the opportunity to train 
unfamiliar words. The speech recognition engine onboard vocabulary 
contains approximately 250,000 words.  

Speech and Voice Recognition Training Tips 

Presentation Voice  

 Speaking clearly and consistently will improve recognition accuracy. 
The speech recognition engine needs to hear acoustical boundaries 
between words.   

 Use the same vocal effort that you use when addressing a class or 
other audience. In other words, use your presentation voice and posture 
when training the iCommunicator program to recognize your speech 
and voice characteristics. Imagine that you are addressing at least 47 
audience members.  

Rate of Speech 

 Speak at a comfortable pace and not too fast. The speech recognition 
engine can efficiently translate speech delivered at rates up to 160 
words per minute. 

 Use pauses as you naturally do during continuous speech. 

Enunciation 

 Enunciate words clearly and speak normally.  

 Avoid exaggerating lip movements or words. It is important to speak 
clearly so the program can identify acoustical boundaries between 
words.  

Microphone Placement 

 Microphone placement is extremely important for accurate speech 
translation. Place the microphone in the same position each time you 
use the iCommunicator program.  

 Squeeze the microphone through the windscreen and verify the 
microphone diaphragm is in the appropriate location.  
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Preventing Vocal Strain During Training 

 Use good posture. Use vocal effort characteristic of your presentation 
voice. Breathe deeply from your abdomen, not from your chest. 

 Take occasional breaks. 

 Keep your vocal cords moist. Use a straw so you do not have to move 
the microphone. 

Eating, Chewing, and Dictating 

 Avoid eating, chewing gum, or drinking liquids while the microphone 
is ON.  

 Use the mute switch to avoid transmitting non-speech sounds. 

Eyes Off the Screen 

 When dictating, try not to watch the computer screen.  

 Viewing the text while dictating sometimes causes speakers to speak 
unnaturally. You can make corrections later. 

Saving Small Segments 

 After completing general training and vocabulary building, use your 
presentation voice while the iCommunicator translates your speech.  

 Make corrections, and then save small segments of accurately 
translated speech. This helps in building, customizing, and fine-tuning 
your speech/voice file. 

Judicious Use of the Mute Switch 

 Use the Mic/Mute switch to avoid transmitting unwanted information, 
such as private conversations and non-speech sounds such as a cough.  

 The computer tries to analyze all sounds, and may translate 
environmental sounds as unfamiliar words. 

Rerun Audio Wizard 

 If you train the program in an acoustical 
environment that is different from the one 
where you plan to use the iCommunicator 
program, rerun the Audio Wizard in the 
planned environment before you use it to 
translate your speech.  
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 From the Options menu, select Speech Recognition  Audio Wizard 

 A red warning screen displays to ensure that you are performing this 
action on the correct speech/voice file. 

 Rerun Audio Wizard whenever any of the following conditions occur: 

 noticeable change in the speaker’s voice  

 the acoustical environment changes 

 a different microphone is used 

 the sound card in the computer has been changed 

 translation accuracy is degraded 

 red appears on the iCommunicator’s microphone status 
indicator (sometimes referred to as redlining) 

Dictating or Speaking in Your Own Speech/Voice File 

 When dictating or speaking using the iCommunicator, always be sure 
that you select your own speech/voice file from the Current Speaker 
drop-down list.  

 A red speaker verification screen appears at specific points to remind 
speakers when they are about to take action on the selected speaker’s 
speech/voice file.  

Accuracy Checks 

 Use the prepared materials in Appendix B.  

 Calculate your accuracy using the chart provided. 

Fine tuning your speech/voice recognition file 

 After reading two or three stories and adding vocabulary, read chapter 
summaries, a glossary, or other documents that contain the specific 
vocabulary and technical terminology that you typically use in your 
workplace or special application environment.  

 Analyze documents available in electronic format to build the 
linguistic and lexical model. 
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Initial Speech and Voice Recognition Training Overview  

During speech and voice recognition training, the iCommunicator program 
learns about your speech and voice characteristics by listening as you 
speak into the microphone.  

The stories you read are selections from best selling books that the speech 
recognition engine has stored and analyzed. Because the speech 
recognition engine already knows the text that you are reading, it uses this 
time to model your voice and learn how you pronounce words. After 
reading one or two short stories, you will personalize S/V files by 
analyzing documents and building vocabulary. The flowchart below is an 
overview of the S/VR Training process. A more detailed flowchart may be 
found in Appendix B. 

 

Follow these steps to build your speech/voice recognition file. The 
program will remind you at strategic points to complete various exercises.  

1. Read Create a New User, page 77, through Initial Speech/Voice 
Recognition Training, page .85  

2. Return to Create a New User, page 77, and then continue to 
Calibrating the Microphone on page 79, and Initial Speech/Voice 
Recognition Training on page 85. 
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3. Read Run General Training on page 90, and then read a second 
selection. 

4. Complete the Accuracy Check as described on page 92. 

Create a New User  

Creating your speech and voice file is a systematic process. First, you 
must provide the iCommunicator program with your name, the speech 
model, and your vocabulary choice when you begin to create your 
speech/voice recognition file as a new user. It is important to select the 
BestMatch III speech model. The BestMatch III technology takes full 
advantage of the powerful CPU in your computer. The vocabulary size 
should be Large. User-friendly prompts on the New User Wizard screen 
will guide you through this process. 

When the iCommunicator program has the necessary information, it 
generates your speech/voice recognition file, loads the files, and loads a 
basic vocabulary to support your use of the iCommunicator program. 

1. From the Options menu, select Speech Recognition  Create New 
Speaker 

2. Read the two information screens, and click OK after each one.  

 

 
 

When the New 
User Window 
appears, type 
the desired 
name in the 
Your Name 
area, and then 
click the 
Advanced 
button.  
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New User Wizard opens to the Create New User screen. 

3. Enter your name. This field can hold up to 127 characters. 

4. Press Tab to navigate to the next field. 

5. Click the Advanced button to choose the speech model and vocabulary 
size.  

 

Ensure that the Speech Model is 
set to BestMatch III. If not, click 
the dropdown menu and select it. 

Verify that the Vocabulary Size 
option is set to Large. If not, 
select it from the dropdown menu, 
and then click OK. 
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Verify the following selections. If the recommended choice does not 
appear, click on the drop down menu and select the preferred choice listed 
below. 

 “Speech Model” is Best Match III 

 “Vocabulary Size” is Large. 

 “Custom, based on advanced selections” will appear in the New User 
Wizard’s Vocabulary window. 

6. Choose OK to accept your changes. 

7. Click Next.  
 

Calibrating the Microphone 

The headset noise canceling microphone is a critical component in the 
accurate translation of speech when using the iCommunicator program. 
The microphone’s placement and performance directly affect the 
program’s ability to recognize and translate speech. The New User Wizard 
includes a simple process to calibrate microphone volume input level and 
check the audio quality. This is the same simple procedure you will use 
when you run the Audio Wizard as you use the iCommunicator program. 

Several factors can affect the calibration process. Before you run the 
calibration, always complete a System Check with attention to the 
following: 

 LightSPEED transmitter and receiver are set to the same frequency 
channel 

 LightSPEED transmitter and receiver powered ON and batteries fully 
charged 

 microphone switch is in the ON position 

 microphone is positioned along the jaw line and slightly away from the 
mouth  

 LightSPEED: rounded portion of microphone toward the jaw 
line and flat portion away from the mouth 

 Parrott Bermuda: flat side of microphone toward the jaw line 

If you receive an error message during audio calibration, investigate other 
factors. Consult the Dragon NaturallySpeaking help files for additional 
information. Simply click the New User Wizard Help button. 
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Position Your Microphone 

The first screen you will see again stresses the importance of microphone 
position. For additional information regarding your specific microphone 
(professional or standard), refer to page 20. 

 

Adjust Your Microphone: Volume Check 

The program will test and adjust the volume of your sound system during 
the Volume Check. You will read some text aloud for about 15 seconds, 
and then move on to the Audio Quality Check. Follow these steps to 
complete the Volume Check. 

1. Set the Mic switch to the ON position. 

2. Click the Start Volume Check button. 

3. Begin reading the text aloud, using the same vocal effort you use in 
your classroom or workplace  

A black meter moves downward in the blue scale as you read. The 
computer beeps when the volume check is finished. “Finished” 
displays at the bottom of the screen.  
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Adjust Your Microphone: Volume Check 

1. If the volume indicator remains at the top of the scale, the volume test 
is not acceptable. You must recheck equipment settings and reread the 
passage. This typically occurs when the speaker forgets to turn on the 
microphone. 

2. When the volume level has adjusted successfully, choose Next to 
continue. 

 



iCommunicator Program 
User Training 

82 

 

The New User Wizard advances to the quality check dialog box. You 
will read aloud again while the computer checks the quality of your 
audio input. 

Sound Quality Check  

1. Verify that your microphone is ON. 

2. Click the Start Quality Check button and read aloud the paragraph in 
the middle of the screen. A green and yellow graph displays as you 
speak. Keep reading until the computer beeps. 

 Tip: Wait a few seconds for the yellow and green graph to 
diminish in size before you read the text that displays. 
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Signal-to-Noise Ratio (SNR) 

The speech-to-noise ratio (SNR) displays when the quality check is 
complete. An acceptable value is within the low 20s to low 30s 
range, and must be a minimum rating of 22. 
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Dragon NaturallySpeaking will indicate that 15 is acceptable; 
however, based on the quality testing performed by the manufacturer, 
we  recommend that the minimum SNR be no less than 22. If your 
rating is below 22, it will be necessary to reread the paragraph. A low 
SNR rating requires the program to use more resources, resulting in a 
slower rate of speech to text conversion. 

The graph showing the SNR should be approximately 90% green 
(speech) and 10% yellow (noise). 

If an error message appears advising that your sound level is too low, 
click OK, and then recheck your system. Very often the problem is 
that the microphone is not turned on.   

 

Before you proceed, recheck your system and repeat both steps of the 
process to recalibrate your microphone   volume check and audio 
quality check. 

3. When the audio quality is acceptable, click the Finish button. 

4. Turn off your microphone. 
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Initial Speech/Voice Recognition Training  

After you create a speech/voice file and calibrate the microphone, next 
you will complete initial speech/voice recognition training. You must 
complete this step to be able to use the iCommunicator program to 
translate your speech. This process takes five to ten minutes. You will 
dictate two sentences into your microphone and then read a short selection 
entitled “Talking to Your Computer.” As you speak, you will train the 
program to recognize your speech and voice characteristics as you 
pronounce words. Initial speech/voice training is the first step to achieving 
translation accuracy. 

Before you perform initial speech/voice recognition training, consider the 
difference between your reading voice and your speaking voice. It is 
essential that you use the same vocal intensity and effort you normally use 
in the environment where you will use the iCommunicator program. 
Speech/voice recognition is based solely upon what the program hears. 
When your training voice differs significantly from your speaking voice, 
the translation may not be as accurate. Consciously resist the urge to train 
the program in your reading voice, and the program will respond more 
accurately when you use the program in the classroom, workplace, or 
other public venue. 

You must complete the initial voice training in order to create your own 
speech/voice file. It is necessary to read the first story to calibrate your 
speech/voice file. If you do not complete this step, iCommunicator alerts 
you that you did not calibrate your speech/voice file when you attempt to 
use the program as an identified speaker. Remember to load files to the 
computer to adapt to your writing style after you complete the initial 
reading 

 Tip:  Check your system before you begin this part of the training. 
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Begin Initial Speech/Voice Recognition Training 

The New User Wizard screen opens, inviting you to train Dragon 
NaturallySpeaking.  

 

1. Click Go and read aloud the sentence in the text box.  

As you read, the yellow (listening) indicator changes to green 
(receiving speech). 

You will read another sentence on the next screen: “Training is about 
to begin.” 

The Select Text screen opens. We recommend that you select “Talking 
to Your Computer” for the initial training. This instructive selection 
takes about five to seven minutes to read. 



Module 4 
Vocabulary Building 

87 
 

 

2. Click OK after you select the story.   

 

 
 

3. Read the story aloud using your presentation voice. As you read, a 
yellow arrow advances and after you complete a word, the text 
changes from black to gray. If the program does not understand a word 
you read, it will either ignore the mistake or display the yellow arrow 
pointing to the word it did not understand. This indicates that you 
should repeat the word in order to advance the arrow and add to your 
speech and voice file. You should try to read the text that appears in 
the text window. However, if you read something incorrectly, the 
computer will either ignore the mistake, or display the yellow arrow. 
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 Tips:   

 Use the Pause button if you need to take a break.  

 Use the Skip button if the program does not recognize how you 
pronounce a word, or if a word is unfamiliar. 

 Use the Redo button to reread a passage. 

 The blue progress bar indicates the amount of text remaining to 
read. 

 Be sure to continue reading until the program prompts you to 
click the Finish button; otherwise, the program will not save 
the reading you have completed. 

When you complete the last paragraph in the story, the 
Congratulations window appears. 

 

4. Click OK.  

The program now begins adapting to your voice. It will take a few 
minutes for the program to adapt and save your speech/voice file.  

5. Turn off your microphone. 
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Accuracy Check   

The iCommunicator program now has a minute sample of your speech and 
voice patterns. You will now complete an Accuracy Check to determine 
how well the program is able to translate your speech. Return to the main 
screen of the iCommunicator program to complete the Accuracy Check. 

The Accuracy Check prepared script is provided in Appendix B. The 
Accuracy Check contains two phonetically balanced paragraphs   “The 
Rainbow Passage” and “My Grandfather”. Follow the directions and read 
the two paragraphs, including the titles (232 words).  

1. Turn on your microphone. 

2. Use your presentation voice and read the paragraphs. 

3. Compute your accuracy using the chart at the bottom of the page. 

 Tip:  Expect some inaccuracies at this point, since the iCommunicator 
program has only a small sample of your speech and voice characteristics. 
If your accuracy is below 90% you may choose to read a second story by 
accessing Run General Training. Go to the Options Menu, Speech 
Recognition, and select Run General Training. 

Adapting to Your Writing Style 

You have now completed the Initial Speech/Voice Recognition Training. 
The initial 5 to 7 minute reading, followed by some vocabulary building, 
should be sufficient for most speakers to achieve a very high rate of 
speech-to-text translation accuracy. Speakers can choose to complete a 
second reading by following the Run General Training process described 
later in this module.  

After the program adapts to your speech and voice patterns, the New User 
Wizard invites you to adapt Dragon NaturallySpeaking to your writing 
style. This step is recommended to increase translation accuracy, and only 
requires that speakers provide files for the program to analyze. If a speaker 
has files on the computer, this is recommended, because it will increase 
the speaker’s overall recognition accuracy when he/she speaks to the 
computer. The program will analyze the following types of files: Text, 
Rich Text Format, Microsoft Word, and Word Perfect. A speaker may 
wish to load technical documents, a vocabulary list, and other information 
available in electronic format. If you are analyzing only a few documents, 
the process should take only a few minutes. 
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If you wish to skip this step, click inside the box. 

A tutorial is available by clicking the appropriate box on the next screen 
exercise. 

Return to page 77 and complete Create a New User, Calibrating the 
Microphone, and the Accuracy Check. 

Follow the steps to complete the Initial Speech/Voice Recognition 
Training process.  

Run General Training  

If you did not reach 90% accuracy on the Accuracy Check, read one more 
story to build a representative speech/voice file. You will complete an 
Accuracy Check following the selection. 

 Tip:  Remember to use the Pause, Skip, and Redo buttons as needed 
during this dictation process. 
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1. From the Options menu, select Speech Recognition  Run General 
Training 

2. A red warning screen appears. Select 
Yes to proceed. 

4. The Select Text window displays.  
There are seventeen selections, 
ranging from easy to difficult reading, 
and covering various topics such as 
adventure, humor, science fiction, 
historical speeches, and classic 
literature. 

 
 

 

Reading Selection 

1. Highlight and select a story from those displayed.  

 Tip:  Some selections contain humor. The speech recognition 
engine will attempt to translate laughter as speech. 

You will read two introductory screens (“Welcome to General 
Training.” and “Training is about to begin.”) before reading your 
selection. It will take about ten minutes to read the story.  

5. Turn on your microphone. 

 Tip:  Remember to use the same presentation voice that you used 
while reading the first selection.  
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6. Read the second selection. 
 

Accuracy Check   

The iCommunicator program now has approximately a 15-20 minute 
sample of your speech and voice patterns. You will now complete an 
Accuracy Check to determine how well the program is able to translate 
your speech. Return to the main screen of the iCommunicator program to 
complete the Accuracy Check, as you did following the initial reading. 

1. Turn on your microphone. 

7. Use your presentation voice and read the paragraphs. 

8. Compute your accuracy using the chart at the bottom of the page. 

 Tip:  Expect some inaccuracies at this point, since the 
iCommunicator program has only a small sample of your speech and 
voice characteristics. You will see your accuracy improve after reading 
the second selection.  

You have now completed the initial speech/voice recognition training. In 
the next module, you will begin to customize your speech/voice 
recognition file using vocabulary building activities. 

Speed Vs Accuracy Adjustment 

Sometimes the speech recognition engine requires a little fine tuning if 
you find it is mistranslating words. There is an adjustment within Dragon 
NaturallySpeaking called Speed Vs Accuracy that adjusts how much 
processing time it uses for speech/voice recognition.  

The Speed Vs Accuracy option adjusts the number of words and phrases 
that the program evaluates in order to find a word match. The more words 
examined, the greater the possibility of an accurate match, although it 
make take slightly longer for the program to recognize your speech. The 
default is set for the fastest response. You can make an adjustment so that 
the program will take a little more time as it makes the decision about 
what words to translate. This change will only apply to your speech/voice 
file. Other speakers may choose to make this adjustment to their file later.  

It is unnecessary to make an adjustment to the Pause Required Before 
Commands. The default setting at 250 msec. is appropriate for most 
speakers. 
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Follow these steps to make the adjustment. 

1. Open the Start menu on the taskbar. Select Programs  Dragon 
NaturallySpeaking. 

2. The Manage Users screen appears. Select your speech/voice file and 
click Open. 

3. The Dragon Menu Bar appears. From the Tools Menu, select Options 
 Miscellaneous. 

4. Move the Speed Vs Accuracy slider one or two graticals to the right. 
Click Apply and then click OK. 

5. Close the Dragon program and return to the iCommunicator main 
screen. 

6. Run Audio Wizard again after changing this setting. 

7. Complete another Accuracy Check. Then speak into your microphone 
and determine if this adjustment has made an improvement in 
translation accuracy. 

Move the 
slider for 
Speed Vs 
Accuracy 1 or 
2 graticals to 
the right to 
allow the 
program 
slightly more 
time to make 
translation 
decisions. 
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Module 3 Review 

True or False 
____ 1. For speech/voice recognition to work properly, you must select BestMatch III 

as the speech model. 
 

  
____ 2. You must perform every step in the New User Wizard to create a new user. 

 
 

  
____ 3. Proper use of the microphone and careful calibration of the system’s audio 

quality are two factors that significantly affect the accuracy of speech/voice 
recognition. 

 
  
____ 4. The speech recognition engine will perform accurately even if you train the 

program using your reading voice and dictate into the computer using your 
speaking voice. 

  
____ 5. Rerun Audio Wizard every day before you use iCommunicator. 

 
 

 
Multiple Choice 
6. Which should you always check before creating a new speaker? 

a. Make sure your transmitter and receiver are turned on and receiving adequate 
power. 

b. Make sure the transmitter and receiver are set to the same frequency. 
c. Make sure the audio button on the transmitter is set to the ON position. 
d. All of the above. 
 

7. The benefits of reading more than one selection during speech/voice recognition 
training include: 
a. more opportunity for iCommunicator to learn to recognize your voice. 
b. exposure to more words and a larger vocabulary. 
c. a higher degree of speech recognition and speech-to-text translation. 
d. All of the above. 
 

8. When you dictate into the microphone, you should always 
a. speak as quickly as possible. 
b. speak as slowly as possible. 
c. speak clearly and enunciate your words. 
d. none of the above. 

Check your answers using the Answer Key in the Appendix. 
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Module 4 Module Objectives 

In this module, you will learn the skills necessary to:  

 use the Vocabulary Builder 

 add vocabulary from a document file 

 use the Vocabulary Editor 

 correct translation errors 

Preview: Vocabulary Building 

During each phase of speech/voice recognition training, the words you 
speak become part of a basic vocabulary stored as your speech/voice 
recognition files. The iCommunicator program relies upon this vocabulary 
to recognize and translate your speech efficiently and accurately.  

In real life, we seldom restrict our speech to basic vocabulary alone. 
Names, places, and unique terminology are essential to conveying our 
messages. It is very likely that some of the terminology that speakers use 
will exceed the basic vocabulary assembled by the iCommunicator 
program during speech/voice recognition training. When the program 
attempts to recognize these unfamiliar words, its translation falls to guess-
work. Mistranslations may also occur if the spoken word or phrase sounds 
very similar to the word or phrase that the iCommunicator program 
translated.  

Fortunately, the iCommunicator program offers several ways to add 
specialized terminology using the Vocabulary Builder and the Vocabulary 
Editor. The Vocabulary Builder analyzes the contents of a document file, 
and identifies words not included the iCommunicator program’s lexicon. 
Vocabulary Builder invites you to select and train unfamiliar words so that 
the speech recognition engine will recognize the words when you speak 
them. 

The Vocabulary Builder can analyze text in list form, or as a normal text 
passage. Words saved in list format (one word or phrase per line) add to 
the vocabulary in batch. You can also analyze documents, such as a 
technical article, chapter summary, or glossary of terms, and add the 
unknown words at your discretion. 
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The Vocabulary Editor provides an interactive way to add new words to 
your vocabulary. Using the Vocabulary Editor, type the words you wish to 
add to the program’s vocabulary. Vocabulary Editor lets you specify one 
form of the word for its spoken form (e.g., “Doctor”) and another form of 
the word for its written translation (e.g., “Dr.”). Another example is the 
use of acronyms, such as IRS and its written counterpart, Internal Revenue 
Service. 

After you enter new vocabulary words and train the program to recognize 
the words, errors sometimes occur. The speech recognition engine lets you 
correct such errors using a simple voice activated command known as 
“Correct That”. Building and refining your vocabulary and training the 
program to recognize new words will improve your accuracy and the 
iCommunicator program’s effectiveness as a communication access tool. 

Vocabulary Building Overview 

Vocabulary Builder analyzes documents that already exist. The 
vocabulary building process gathers information about your specific 
writing style and identifies unfamiliar words so you can add them to 
customize your speech/voice file. After you add and train new words, you 
will need to save your speech file by accessing the Options Menu ► 
Speech Recognition ► Save Speech File. 

The greatest advantage of adding vocabulary in this manner is speed. The 
iCommunicator program can analyze a document and add a large number 
of words to your vocabulary far quicker than you can by individually 
entering each word. 

Vocabulary changes apply only to the current speaker. If several speakers 
have speech/voice files that will be used with the iCommunicator 
program, and each uses a specialized vocabulary, then each speaker must 
add the vocabulary to his or her speech/voice recognition file. 

Begin to make a list of words and phrases that are unique to your use of 
the iCommunicator program. For example, iCommunicator is a word that 
is not in the program’s dictionary, and each speaker must add this word. 
You will note that iCommunicator is on the vocabulary list in the text file 
you downloaded from www.myicommunicator.com.  
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Analyze Documents 

By Analyzing documents, you have the opportunity to personalize a 
vocabulary to more closely match your writing style that typically reflects 
your speaking style, particularly in the area of vocabulary usage and 
phrases. Analyze existing documents or manuscripts, electronic forms of 
textbooks, or reference documents, word lists, class, or employee lists, 
glossaries, and similar materials to build and customize your speech/voice 
recognition file.  

 Tip:  Analyze a word list as a document rather than as a list. You will 
then have the opportunity to train the program for words not recognized.  

Saving Speech/Voice Files 

 Tip:  Always save your speech files after making vocabulary changes.  

If you forget to do this, the program prompts you to do so the next time 
you change speakers, or exit the iCommunicator program. 

1. From the options menu, select Speech Recognition  Save Speech 
Files.  

2. This is the only way to save your recordings. Choosing the Save 
option under the file menu saves only the text in the Text window (not 
speech files). 

9. A red warning screen appears.  

10. Click Yes and proceed. 
 

Acronyms and Other Unique Text 

You can add acronyms or other text, and then have the program show the 
actual words, or vice versa. Some examples follow. 

Spoken Form Written Form 
IEP Individual Education Plan 
United States of America USA 
my email address info@myicommunicator.com 
our website www.myicommunicator.com 
my telephone number        123-456-7000 
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Add common phrases, colloquial speech, and contemporary phrases to 
your speech/voice file using the Vocabulary Editor. Some examples 
include: good morning, good afternoon, instructional technology 
department, deaf and hard of hearing, fixin’ to, and Better Hearing and 
Speech Month. 

Working with Document Text Files 

Dragon NaturallySpeaking allows for documents saved in the 
following formats to be analyzed under a speaker’s speech/voice file. 
Existing documents, or files from the Internet, such as classic literature, 
can be saved in one of these formats for analysis. Consult the Dragon help 
menu for useful information about preparing documents to add to the 
vocabulary. 

 ASCII text (.txt) 

 Microsoft Word (.doc) 

 Rich Text Format (.rtf) 

 Corel WordPerfect (.wpd) 

 HyperText Markup Language (.htm or .html) 

Scanning Documents for Vocabulary Building  

Scan documents such technical reports, chapter summaries, glossaries, and 
other information pertinent to the speaker’s typical vocabulary. The 
scanner must have optical character recognition (OCR) capability so that 
the program can read the words as text. Save the scanned document as a 
text file in .rtf format. 

Vocabulary Builder:  Analyzing Documents  

You will complete several exercises as you proceed through this portion of 
the training manual. Later, you will continue vocabulary building to 
improve translation accuracy. 
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System Check  

1. Check your system using the System Checklist appropriate for your 
microphone (i.e., professional or standard). 

11. Make sure that your name displays in the Current Speaker window. 

12. In the Control window, click the Microphone Status Bar or 
Microphone On/Off button so that the microphone is off, that is, 
totally black. 

 

Starting Vocabulary Builder 

1. From the Options menu, select Speech Recognition  Vocabulary 
Builder  Vocabulary Builder. 

 
 

13. A red warning screen appears. Click Yes and 
proceed to the next screen. 

14. The Vocabulary Builder Welcome Screen 
appears. 

15. Read the information on the screen and click 
Next.  

 
 
 
 



Module 4 
Vocabulary Building 

101 
 

 
 

At this point, the Vocabulary Builder advances to the Add Words From a 
List dialog box. Only use this feature if the file you wish to analyze is a 
word list. Using this feature to analyzing the word list will not give you 
the opportunity to train words. We recommend that you use the Analyze 
Documents feature to analyze word lists so that you will have the 
opportunity to train unfamiliar words. 

Analyze Documents 

To analyze a document: 

1. Click Next. 

The Analyze Documents dialog box appears. 
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16. Click Add.  

17. Click Browse to locate your text file(s).  

18. Select one or more text files to analyze.  

 Tip:  You can select multiple documents to analyze by holding 
down the Control key while you click to select files. 

19. Click Open. The file path name then appears on the Vocabulary 
Builder screen.  

20. Choose the Analyze Documents button.  

This process is very quick. You will notice that as document analysis 
completes, the comment in the Analyzed column changes from No to 
Yes.  

21. When the program is finished processing all of your text files, click 
Next.  

 
Exercise: 

1. From the File menu, select Open, and then select the Temp File (or 
another file where you stored text files). 

22. Click on the first file. 

23. Press and hold down the Control key while you click on all of the 
other files in the folder. 

24. Click Open. (All of the files now appear in the Analyze Documents 
window.) 

25. Choose Analyze Documents. (Observe as the No changes to Yes in the 
Analyzed column.) 

 

Add New Words 

Review the steps in this process, and then complete the exercise. 

After the program finishes analyzing your text documents and you choose 
Next, the Add New Words screen appears. Words that the program does 
not recognize appear here. The number of times each unfamiliar word 
appears in the file analysis displays in the Frequency column. 

1. If you want to change the default settings, select options using the 
radio buttons and checkboxes on the right of the screen. 
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26. Most users find that the default settings are adequate. 

27. Check each word you want to add to your vocabulary. If you wish to 
add all the words, simply click the Check All button.  

28. Correct misspelled words using the Edit button. 

  

 
 

29. Use the Edit button to add a word (or abbreviation) that has a different 
spelling than the written form. For example, to say IRS but have the 
program display Internal Revenue Service, use the Edit button to make 
the appropriate changes.  

30. When you finish your selections, choose the Add Checked Words to 
Vocabulary button. 

 
Exercise: 

1. Click inside the box beside each word you want to add to your 
vocabulary.  

Note: Select the box beside the word iCommunicator. 

31. If words are misspelled, click Edit, and then correct the spelling. 

32. After selecting which words to add, choose the Add Checked Words to 
Vocabulary button. 
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Train Words 

Review the information in this section and then complete the exercise. 

A dialog box displays and asks if you want to train the new words.  

1. Choose Train.  

The Train Words dialog opens. 

 

33. Turn on the microphone. 

34. Say Go, and then say each word as it appears in the text box.  

Use your presentation voice. The microphone bar changes from yellow 
to green when you say each word. If a second or third bubble appears, 
that is your prompt to repeat the word. 

35. Choose Done when you finish training.  

36. Turn off the microphone. 
 

Adapting Vocabulary 

Proceed through the remaining steps to complete the Vocabulary Builder 
exercise. You can follow this procedure to analyze additional documents 
in the future. 

1. When you finish training all words, the Add New Words dialog box 
appears again. Click Next. 
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37. The Adapt to document style dialog box appears. Accept the default 
settings, and click Next. 

38. Choose Finish, and then confirm by clicking Yes.  

39. Save your changes (from the Options menu, select  Speech 
Recognition  Save Speech Files). 

40. A red warning screen appears. Click Yes to save your speech/voice 
file. 

Vocabulary Editor  

Purpose 

Use the Vocabulary Editor to enter and train individual words you want to 
add, or to delete unwanted words. When Vocabulary Editor opens, you 
can view the entire vocabulary. It contains approximately 250,000 words. 
The vocabulary changes you make to your speech/voice file will apply 
only to your file and not to other speaker’s speech/voice files. 

You can also use Vocabulary Editor to customize the vocabulary in your 
speech/voice recognition file. When the written form and the spoken form 
of a word are different, such as scientific terminology, abbreviations, and 
acronyms, use the Vocabulary Editor to input these differences. 
 
Examples:  
 
Written Form   Spoken Form 
A+     A plus 
Inc.     Incorporated 
Hz     Hertz 
Ti     titanium 
fixing to    fixin’ to 
www.isi-iCommunicator.com             our website 
hill     heel (regional dialect) 

 

Complete the sample exercises as you proceed through this section. You 
may then add other words using Vocabulary Editor. 
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Getting Ready 

Follow these steps to use Vocabulary Editor. 

1. Check your system. 

41. Verify that your name appears as the current speaker. 

42. Verify that the microphone status bar is on (yellow) before opening the 
Vocabulary Editor.  

 Tip:  Because the microphone is live, it is important that you do 
not speak until it is time to train words; otherwise, you will find 
unwanted letters in the text box, along with the word you wish to add 
and train. 

43. From the Options menu, select Speech Recognition  Vocabulary 
Builder  Vocabulary Editor. (Refer to the figure under Starting 
Vocabulary Builder, page 100.)  

44. A red warning screen displays. Click Yes to 
proceed. 

 
When Vocabulary Editor opens, you can scroll 
through the entire vocabulary. To determine if a 
word is included in the vocabulary, simply type 
the word. When the program finds the word, it 
displays in the list, highlighted. If it is not in the 
program’s vocabulary, it does not appear in the list.  

Adding and Training Words 

1. Type a word such as otoacoustic to see if it is in the vocabulary. 

45. If the word does not display in the vocabulary list, choose Add. The 
word then appears in the list. 
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46. Click Train.  

The Train Words dialog opens. You then train the program to 
recognize the word’s pronunciation.  

The following procedures are the same in both Vocabulary Editor and 
Vocabulary Builder. 

1. Choose Train.  

The Train Words dialog opens. 

 

47. Turn on the microphone. 

48. Say Go, and then say the word that appears in the text box. Use your 
presentation voice. 

49. Choose Done when you finish training the last word.  

50. Turn off the microphone. 

51. Save your speech files. (From the Options menu, select Speech 
Recognition  Save Speech Files.) 
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Correcting Errors Using “Correct That”  

Purpose  

Sometimes the iCommunicator program is unable to translate a word or 
phrase correctly, especially technical vocabulary or uniquely spelled 
names. The word must be included in the program’s vocabulary in order 
for accurate translation to occur. You must add unfamiliar words using 
Vocabulary Editor or Vocabulary Builder or by using the Spell dialog box. 

You can choose the Correct That feature to correct a word or phrase that 
translates incorrectly. It is not recommend that you use Correct That to 
add vocabulary. Use Vocabulary Builder or Vocabulary Editor to add new 
words. New words can be added using Spell That, which is available 
through the Correct That process, however, there are some limitations. For 
instance, you cannot use the Spell That dialog box to add a word that has 
hyphens or spaces, such as “Smith-Jones” or info-iCommunicator, because 
the program recognizes each part of such a word as a separate word. To 
add these types of words, use the Vocabulary Editor. 

It is important not to repeat words that appear incorrectly. Correct them 
the first time you see the inaccurate translation. When you select Save 
Speech Files, the program saves everything you say (both correctly and 
incorrectly), even when text box is clear. The only way to begin anew is to 
exit (without saving) and return, or change to another speaker.  

Some commands for using the “Correct That” feature may be voice 
activated.  

Using “Correct That”  

Use the following steps to correct a word: 

1. Repeat the word once so that it appears (incorrectly translated) on a 
line by itself.  

 Tip:  If the word appears correctly, you will not need to correct it. 

2. Say, “Correct That.” Wait a moment, and the Correction window will 
appear.  

 Tip:  You may use other voice commands such as select, go, train, 
record, and done to easily navigate through this process. 
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52. Select the correct word or text from the numbered list of recognition 
alternatives.                      

In the example above, the speaker actually said, “Did she say ice 
cream or I scream?”  

53. If the correct alternative is not a choice, select Spell That… 

The Spell That dialog box appears. 

 
54. If the correct text is displayed, click the number or say “Choose “x”, 

where “x” is the number of the correct text. If the correct text is not 
displayed, type it in the text box. 

 

The Correction 
window displays 
alternatives 
based on word 
predictability. If 
the correct 
translation is not 
a choice, click 
Spell That. 
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55. Click inside the “Train how to pronounce this” box. Then click OK. 

The Train Words window displays both the correct and incorrect 
word(s).  

 

Teach the program how each word sounds as you record them. It is 
very important to distinctly note the pronunciation differences between 
the two written texts. Sometimes two or three bubbles will show on the 
right, and this means the program wants you to repeat the word one or 
two more times. In this example, the speaker initiates the Go command 
and then repeats both sentences. This teaches the program to 
differentiate between the two sentences. 

56. Click (or say) Go. 

57. Speak the first word or phrase as it appears in the top box. 

58. Speak the second word or phrase when it appears.  

59. Click or say Done.     

The Train Words window closes. 

60. Say the word or sentence again to confirm that the program now 
recognizes it. 

61. Save your speech/voice files. (From the Options menu, select Speech 
Recognition  Save Speech Files.) 
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You can also correct words or phrases by saying, “Correct x”, where (x) is 
the targeted word or phrase. This correction method is useful when you 
review your translations and find a conversion error. The training process 
is the same as Correct That. You can also say “Select x” instead of 
“Correct x” to correct text using voice commands. 

After correcting a word or phrase, return to the main screen of the 
iCommunicator program. Speak the word in a few sentences or phrases to 
confirm that the program recognizes it in context. Then save this correctly 
translated text to your speech/voice file. 
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Continuing to  Fine-tune the Speech/Voice Recognition File  

Continue building your speech/voice recognition file until you achieve 
90% or better accuracy. Most iCommunicator users achieve 90% accuracy 
with the recommended phonetically balanced paragraphs they use to 
complete the Accuracy Checks. Improvement beyond that usually requires 
additional dictation. The more you dictate, the more opportunities the 
program has to listen to your speech and voice characteristics, and to fine-
tune the acoustical, linguistic, and lexical model. 

The following summarizes speech/voice recognition activities that aid in 
building your speech/voice file and help you achieve good translation 
accuracy. 

 Use the common phrase and sentence lists in Appendix B. Record a set 
of ten, then make corrections and save. Repeat with additional sets of 
ten. Also add colloquial expressions. 

 
 Analyze documents you have available on disk or CD. 

 
 Take the time to add words that are specific to the vocabulary you use 

in the classroom or workplace. Examples include names of students 
and co-workers, technical vocabulary and phraseology, commonly 
used acronyms, and colloquialisms. 

 
 If you notice problems with translation accuracy, rerun Audio Wizard. 

 
 Remember that iCommunicator is not as smart as you are! It does not 

know what you meant to say. It needs to hear acoustical boundaries 
between words in order to translate your speech accurately. 

 
 Refer to Speech and Voice Recognition Training Tips, page 73, for 

additional information. 

 
 You can store speech/voice recognition files on a server, zip disk, or 

CD when a speaker is not using the iCommunicator. When the need 
arises again, reload the file on the computer. The speaker then runs 
Audio Wizard and updates vocabulary, if needed. Refer to the 
Archiving and Retrieving S/V Files iTip on page 117 for more 
information. 
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 Another option is available through Dragon NaturallySpeaking. From 
the Start menu in the taskbar, select Programs ► Dragon. The Manage 
Users screen appears. Select your voice file and choose Open. Go to 
the Tools menu on the Dragon Menu bar, and select Accuracy Center. 
Here you will find some helpful tips for fine-tuning your speech/voice 
file, as well as troubleshooting tips.  

 
 Another very useful tool available in Dragon’s Accuracy Center is the 

Acoustic Optimizer. As you make corrections and add to your 
speech/voice file, the speech recognition engine archives this acoustic 
information and uses it to enhance recognition accuracy. The Acoustic 
Optimizer accumulates this data from each training session. It will take 
some time for the Acoustic Optimizer to process, so make sure that 
you run this option when you have time available for the computer to 
be unoccupied with other programs running. The Acoustic Optimizer 
dialog box will display the amount of time to finish adapting your user 
files and display a progress bar to indicate how much of the job is 
complete. 
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Top Ten Tips for Successful iCommunicator Program Use  

1. End user needs and program features match. 

A match must exist between the end user’s communication access 
needs and the iCommunicator features. It must be the right technology, 
for the right end user, for the right application, and implemented in the 
right way for maximum potential. (Refer to Appendix A 

 
iCommunicator Candidacy Criteria Considerations for further infor-
mation.) 

2. Train end users and speakers. 

End users and speakers need thorough training. Training opportunities 
are available through authorized iCommunicator resellers. Contact 
1450, Inc. for details. 

3. Implementation Managers  

Identify implementation managers and train them in all aspects of the 
program, from training to troubleshooting. These individuals serve an 
important role in successfully implementing the program. 

4. Consistency, consistency, consistency!   

Successful speech translation requires consistent vocal effort, speech 
and vocal patterns, and microphone placement.  

5. Judicious use of the mute switch. 

Using the transmitter’s mute switch enhances translation accuracy. 
The mute capability prevents the program from processing unwanted 
verbiage and sounds. 

6. Routine System Check. 

This becomes a shared responsibility between the end user, speakers, 
and the implementation manager. Translation accuracy degrades when 
the program and its peripherals are not performing optimally. 

7. Rerun Audio Wizard. 

Run Audio Wizard any time there is a change in the speaker’s voice, 
the acoustical environment, the microphone, or the computer’s sound 
card. You should also rerun Audio Wizard when you notice 
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degradation in translation accuracy, or when the iCommunicator’s 
microphone status bar shows red (redlining) while speaking. Audio 
Wizard completes in less than a minute. 

8. Add New Vocabulary. 

Speakers should add new vocabulary as necessary to ensure that new 
technical terms, names of colleagues, and other such terminology are 
input to the program to enhance translation accuracy. 

9. Not a replacement for sign language interpreters – an alternative. 

The iCommunicator is not intended to replace sign language 
interpreters, but is an alternative for situations where its capabilities 
meet the end user’s needs and/or specific application. Due to the 
concern about literacy levels of persons who are deaf or hard of 
hearing, iCommunicator delivers American Sign Language (ASL) 
signs in English word order. The iCommunicator has applications for 
others who face communication access challenges. 

10. Call for assistance and check for update information. 

For technical assistance, contact Customer Service. at 800-245-2133. 
Visit our website at www.myicommunicator.com for periodic updates. 
Use the website and the toll free number to share your comments and 
ideas with us. 
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Module 4 Review 

True or False 
 
____ 1. You type new vocabulary words into the Vocabulary Builder. 

 
 

  
____ 2. You can display the entire vocabulary in the Vocabulary Editor. 

 
 

  
____ 3. The Vocabulary Builder can analyze a text file saved in .doc, .rtf, .xls or .txt 

file formats. 
 

  
____ 4. You should train any new words you add to your vocabulary. 

 
 

  
____ 5. You should repeat a mistranslated word a second time before using the 

Correct That command. 
 

 

Multiple Choice 

6. Which is not correct regarding the Correct That command? 

a. You select the Correct That command from the menu in the  
Dragon NaturallySpeaking dialog box. 

b. You verbally speak the Correct That command. 
c. Issuing the command opens the Correction dialog box. 
d. Possible replacement words are listed in the Correction dialog box. 

 

7. The Vocabulary Editor 

a. is an appropriate tool for quickly adding a large number of vocabulary words. 
b. analyzes a text file for unknown words. 
c. is used to save your speech files. 
d. lets you type in and train new vocabulary words. 

 
Check your answers using the Answer Key in the Appendix. 
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Archiving and Restoring Speech/Voice Recognition  
Files 

There may be times when it is necessary to backup a speaker’s 
speech/voice (S/V) file:  

 a speaker completes S/V recognition training on one computer and 
needs to transfer the S/V file to another computer 

 to remove a speaker’s S/V file from a computer and save it for future 
use 

A speaker’s S/V file is typically 30 to 40 MB, but may be more than 80 
MB. This file size limits storage to Zip Drives, Local Area Network 
(LAN), LS-120 SuperDisk Drives, or CD-R(W) Drives. Follow the 
procedures below to archive and restore a speaker’s S/V recognition file. 
Review each procedure before initiating the process. 

Location  

Each speaker who establishes a speech/voice recognition file within the 
program has his or her own named folder inside the User’s folder.  

Speech/voice recognition files for iCommunicator Version 4.0 are located 
in C:\Program Files\Dragon\NaturallySpeaking\Users\Speaker S/V file 
name. 

Archive Procedure  

Use Windows Explorer to copy S/V files to the appropriate external 
device destination, such as a Zip Drive, LAN, Superdisk Drive, or CD-
R/W. 

1. From the Windows Start button, select Programs  Accessories  
Windows Explorer. 

62. To back up all S/V files on the computer system, navigate to the User 
folder (My Computer, C: Drive, Program Files, Dragon, 
NaturallySpeaking, Users, Speaker S/V file name). Select the User 
folder, and then copy it to the appropriate destination. 
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63. To backup a specific S/V file, navigate down one level and then select 
speaker’s S/V folder you wish to backup. (From the left panel select 
My Computer. Then select the following path. 
C:\ProgramFiles\Dragon\NaturallySpeaking\Users\ Speaker S/V file 
name). 

64. Copy the speaker’s S/V folder to the appropriate destination. 
 

Restoring Speaker S/V Files 

1. To restore all speakers, copy the previously backed-up User folder to 
drive C:\Program Files\Dragon\NaturallySpeaking.  

 Tip: This process replaces all speaker files currently recognized by 
the iCommunicator program. If the S/V files recognized by the 
program are valid, use the backup procedure described above before 
you initiate restore process. 

65. To restore a specific  S/V file, copy the speaker’s S/V backup file to 
drive C:\Program Files\Dragon\NaturallySpeaking\Users\Speaker S/V 
file name 

66. Start iCommunicator. 

67. From the Options menu, select Speech Recognition  Create New 
Speaker. 

68. Enter the correct voice file name in the Your Name field, and then 
continue until the Audio Wizard Setup is complete.  

69. Select Cancel and close the iCommunicator program. 

70. You must run Audio Setup the first time you use the restored S/V file. 
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Candidacy Criteria Considerations 

User Characteristics and Skills 

The iCommunicator program provides communication accessibility for 
persons who are deaf or hard of hearing and other persons with unique 
communication challenges. The Candidacy Criteria Considerations 
include end user characteristics and skills that should be considered by 
evaluation and planning teams (e.g., assistive technology, IEP, transition, 
rehabilitation), disability coordinators, human resources departments, and 
other decision-makers to determine the appropriateness of this commu-
nication access technology for a specific end user or special applications 
in a variety of settings, such as education, workplace, and public venues. 

Special Communication Needs 

Individuals with special communication access needs, such as those listed 
below, may be candidates for the iCommunicator  program.  

 Deaf or hard of hearing 

 Significant speech or voice disorder 

 Learning disability (e.g., dysgraphia) 

 Auditory processing disorder, learning disability, and/or severe 
language impairment that results in difficulty with multitasking and 
notetaking 

 Attention deficit disorder that results in the need for notetaker 
assistance 

 Visual impairment (e.g., low vision) 

 Physical impairment 

 English as a Second Language (ESOL)  

Independent Use: Candidacy Criteria Considerations 

These characteristics, abilities, and requirements should be considered by 
the evaluation and planning teams when determining if the 
iCommunicator program is the appropriate communication access 
technology. The criteria considerations for independent use should be 
factored into the evaluation and planning process to reach an informed 
recommendation. Communication access needs should be identified in 
order to determine effectiveness gains. For use as a learning station in a 
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classroom or other facility, there are no limitations, as the use of the 
iCommunicator program would be under the direction of the classroom 
teacher, supervisor, or other professional. 

 
1. Communication Access Needs (i.e., workplace, education, lifestyle) 
 

 a. 
 b. 
 c.             

 
2. Age of user  
 
3. Cognitive level  
 

 Ability to learn and remember new procedures  
 Ability to troubleshoot and/or problem-solve  
 Attention span  
 Divided attention (i.e., ability to divide attention among 

windows displayed, the speaker, and other visual displays in 
the environment)  

 Working memory 
 
4. Language level and primary mode of communication (receptive and 

expressive language skills) 
 

 Language processing ability  
 Vocabulary level  
 Language comprehension level (e.g., ability to chunk 

information, use tag words as meaning clues)  
 Ability to derive meaning using contextual clues  

 
5. Reading comprehension level  
 

 Word recognition level (i.e., at least second grade level)  
 Spelling ability  
 Grade equivalent/Standard Score  
 Visual processing speed  

 
6. Personal Characteristics 

 
 Motivation to use the iCommunicator software program 
 Responsibility and maturity 
 Self-discipline  

 Patience with using this type of technology  
 Appraisal by teacher(s)/supervisors and parent/caregiver  

 



iCommunicator Program 
User Training 

124 

7. Computer literacy  
 
 Keyboarding skills  
 Ability to navigate the Windows operating system  
 Need for external mouse or other peripherals  

 
8. Purpose for use (e.g., classroom instruction, access in the workplace, 

access to services) 
 
 Content (e.g., core subject area, therapy tool, staff meetings, 

training, counseling, intake data)  
 Delivery style (e.g., primarily lecture, highly interactive, small 

groups, one-on-one)  
 Willingness of speakers to provide accessibility by creating a 

speech/voice recognition file and using the technology 
 Amount of use per day  
 Availability of back-up plan for when iCommunicator interface 

is unavailable  
 
9. User supports  

 
 On-site and off-site staff support  
 Technical support  
 Resources (batteries, transporting to classes, cart, case)  
 Family/caregiver/supervisor 

 
Training Requirements and Supports  

 

1. The end user must be completely trained in the operation of the 
iCommunicator program to achieve positive outcomes. End users need 
to demonstrate competency in the use of a computer with respect to 
working within a Windows environment.  

2. Adequate technical assistance/support will need to be available for the 
end user. This will vary with the individual end user’s level of 
independence in using a computer and the software program and the 
specific application of the technology.  

3. Implementation managers should possess computer literacy skills 
necessary to use and maintain the computer, software program, and to 
train both end users and speakers in the unique features of this 
communication access technology. 
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Individuals with Communication Challenges:                       
The Need and Feature Match 

The iCommunicator software program is appropriate for many individuals 
with communication challenges. Careful evaluation of an end user’s needs 
will help in determining which iCommunicator features are best for that 
individual. 

The iCommunicator program is a great benefit for persons who are deaf or 
hard of hearing. However, the program has applications that many other 
individuals who face unique communication challenges can use. For 
instance, persons with auditory processing disorder, learning disability, 
and/or severe language impairment who have trouble with multitasking 
will benefit from the iCommunicator as a sophisticated, note-taking 
technology. Persons with a specific learning disability known as 
dysgraphia and those with motor disabilities may also benefit from the 
program. They can use it to communicate and to take notes during classes, 
discussions, and meetings. Individuals with significant, expressive speech 
or voice disorders may benefit from the voice output capabilities, since it 
allows them to interact independently in personal and group conversations.  

Severe language impairment, either acquired or developmental, may 
require a need for accessible communication devices. The iCommunicator 
provides assistance through the developmental or recovery process. 
Persons with visual acuity and visual perceptual deficits have special 
communication needs, such visual display size and 
background/foreground contrast. The iCommunicator can accommodate 
these needs. Another very large group with special communication needs 
is those whose native language is not English. 

The following table lists these special populations and the iCommunicator 
features that could match their unique communication challenges. Refer to 
the preceding Candidacy Criteria Considerations, for additional 
information about factors to consider in evaluating the iCommunicator as 
an assistive technology for a specific end user. 

 



iCommunicator Program 
User Training 

126 

 

Target Population Needs and Opportunities Related to iCommunicator 
Capabilities 

Auditory Processing Disorders  need for note-taking assistance due to difficulty 
multitasking  

 need for text display due to difficulty applying meta-
linguistic and metacognitive skills necessary for message 
comprehension.  

Deaf and Hard of Hearing  need for sign language to augment oral communication 
in various settings  

 need to improve literacy skills  
 need for voice output to communicate in one-on-one or 
group settings  

 need for note-taking assistance due to difficulty 
multitasking  

 opportunity to improve speech recognition and speech 
intelligibility  

English Speakers of Other 
Languages (ESOL) 

 need for written English to augment oral presentations  
 need to improve English literacy skills  
 opportunity to hear playback notes and stories to learn 
the English language  

 opportunity to improve speech recognition and speech 
intelligibility  

Learning Disability  need for note-taking assistance  
 need for note-taking assistance due to dysgraphia  
 need for visual augmentation due to visual processing 
deficits  

Low Vision  need for increased font size  
 need for high contrast schemes  
 need for voice output  

Physical Disability  need for note-taking assistance due to difficulty 
multitasking  

 need for voice output  
 need for portable assistive technology that will 
accommodate peripheral and/or alternative devices  

Severe Language Impairment 
(developmental or acquired) 

 need for note-taking assistance due to difficulty 
multitasking  

 need for visual augmentation to (re)learn metalinguistic 
and metacognitive skills to enhance comprehension  

 possible need for voice output  
Speech or Voice Disorder  need for voice output device  

 opportunity to improve speech recognition and speech 
intelligibility  
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Appendix B 
 
Speech and Voice Recognition Training:  
 
Flowchart 
 
Accuracy Check 
 
Common Phrases 
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Speech and Voice Recognition Training Flowchart 
System Check  Check all system components, connections, and functions. 
   
Create New Speaker  Options>Speech Recognition>Create New Speaker 
1. Create New User 
2. Calibrate Your Microphone 
3. Initial Voice Training 

“Talking to Your Computer” 

  

   
Run General Training  Options>Speech Recognition>Run General Training 
1. Select a Reading   
2. Accuracy Check    
   
Vocabulary Builder  Options> Speech Recognition> Vocabulary Builder> 

Vocabulary Builder 
   

1. Analyze documents saved as 
text files 

 Examples: manuscripts, electronic forms of textbooks, 
scanned text, other personal/technical documents 

a. Analyze   
b. Train   
c. Save Speech Files  Options>Speech Recognition>Save Speech Files 
   

2. Analyze word lists as 
documents 
a. Analyze 

 Examples: technical vocabulary, content vocabulary, class 
lists, acronyms, other unique vocabulary 

b. Train   
c. Save Speech Files  Options>Speech Recognition>Save Speech Files 

   
3. Vocabulary Editor  Options> Speech Recognition> Vocabulary Builder> 

Vocabulary Editor 
a. Enter   
b. Add  Examples: same as word lists, but by individual entry 
c. Train   
d. Save Speech Files  Options>Speech Recognition>Save Speech Files 

   
Talk to Your iCommunicator   
1. Read/speak sets of 10 familiar 

phrases/sentences 
  

a. Use presentation voice   
b. Correct as needed  Use “Correct”/”Correct That” Feature 
c. Save Speech Files  Options>Speech Recognition>Save Speech Files 

2. Deliver content-specific and 
casual speech 

  

a. Use presentation voice   
b. Correct as needed  Use “Correct”/”Correct That” Feature 
c. Save Speech Files  Options>Speech Recognition>Save Speech Files 

Remember to speak in your presentation voice. If 
accuracy is 90% or better on the Accuracy Check, 

skip the second reading. 

To enhance your translation accuracy, remember to: 
• make judicious use of the mute control to avoid transmitting 

unwanted verbiage 
• save short, correct(ed) passages to your speech/voice file 
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Accuracy Check Using Phonetically Balanced Paragraphs 

Read these two phonetically balanced paragraphs, including the titles, and 
then check your accuracy using the chart on the next page. 

The Rainbow Passage 

When the sunlight strikes raindrops in the air, they act like a 
prism and form a rainbow. The rainbow is a division of white 
light into many beautiful colors. These take the shape of a long 
round arch, with its path high above, and its two ends 
apparently beyond the horizon. There is, according to legend, a 
boiling pot of gold at one end. People look, but no one ever 
finds it. When a man looks for something beyond his reach, his 
friends say he is looking for the pot of gold at the end of the 
rainbow. 

My Grandfather 

You wish to know all about my grandfather. Well, he is nearly 
ninety-three years old, yet he still thinks as swiftly as ever. He 
dresses himself in an old black frock coat, usually several 
buttons missing. A long beard clings to his chin, giving those 
who observe him a pronounced feeling of the utmost respect. 
When he speaks, his voice is just a bit cracked and quivers a bit. 
Twice each day he plays skillfully and with zest upon a small 
organ. Except in the winter when the snow or ice prevents, he 
slowly takes a short walk in the open air each day. We have 
often urged him to walk more and smoke less, but he always 
answers, “Banana oil!” Grandfather likes to be modern in his 
language. 
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Compute Your Accuracy Score 

Use the chart below to compute your accuracy rate. (Subtract the number 
of translation errors from 232 and locate your accuracy rate.) 

Raw Score % Raw Score % Raw Score % 
232 100.00 208 89.66 184 79.31 
231 99.57 207 89.22 183 78.88 
230 99.14 206 88.79 182 78.45 
229 98.71 205 88.36 181 78.02 
228 98.28 204 87.93 180 77.59 
227 97.84 203 87.50 179 77.16 
226 97.41 202 87.07 178 76.72 
225 96.98 201 86.64 177 76.29 
224 96.55 200 86.21 176 75.86 
223 96.12 199 85.78 175 75.43 
222 95.69 198 85.34 174 75.00 
221 95.26 197 84.91 173 74.57 
220 94.83 196 84.48 172 74.14 
219 94.40 195 84.05 171 73.71 
218 93.97 194 83.62 170 73.28 
217 93.53 193 84.09 169 72.84 
216 94.00 192 82.76 168 72.41 
215 92.67 191 82.33 167 71.98 
214 92.24 190 81.90 166 71.55 
213 91.81 189 81.47 165 71.12 
212 91.38 188 81.03 164 70.69 
211 90.95 187 80.60 163 70.26 
210 90.52 186 80.17 162 69.83 
209 90.09 185 79.74 161 69.40 

 
 
References 

The Rainbow Passage (Excerpted from phonetically balanced reading 
(101 words), Fairbanks, G. Voice and Articulation Drill Book (2nd ed.). 
New York: Harper) 

My Grandfather (Phonetically balanced paragraph [131 words] from 
Charles Van Riper, Speech Correction.) 
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Common Phrases and Sentences for Speech/Voice Recognition 
Training 

Use these common phrases and sentences to build your speech/voice recognition file. 
Read a set of ten, speaking in your presentation voice, and then correct mistranslations. 
Save to your speech/voice file. Read another set of ten, correct, and save. Add more 
phrases, sentences, and colloquial speech that are characteristic of your speech and 
language patterns. Remember to use the mute switch while completing these tasks. 
 
1. Good morning, class. 
2. Take out your book. 
3. Write your name on your paper. 
4. It’s time for lunch. 
5. Where is your book? 
6. Good job! 
7. That’s great! 
8. Time out! 
9. You’re late. 
10. Turn to page 52. 
 
11. Look at this. 
12. Who is absent? 
13. Please sit down. 
14. Raise your hand. 
15. Why did you do that? 
16. Turn around. 
17. Pay attention. 
18. Take your seat. 
19. Let’s begin. 
20. It’s your turn. 
 
21. Here is your hall pass. 
22. Did you know that? 
23. Put away your books. 
24. That’s right. 
25. I’m only kidding. 
26. No way. 
27. That’s cool. 
28. Where are you going? 
29. Please give that to me. 
30. That’s awesome. 
 

31. Don’t you feel well? 
32. Let’s stop here. 
33. Who did that? 
34. I know you can do this. 
35. Go for it. 
36. Give it to me right now. 
37. Pass your papers to the left. 
38. I don’t know. 
39. I have no idea. 
40. No, thank you. 
 
41. Where did you get that? 
42. Let me tell you a story. 
43. What is that? 
44. How could you? 
45. Look it over. 
46. What about it? 
47. Here are some more. 
48. Very well, thank you. 
49. Please do. 
50. As I said before… 
 
51. How could you do that? 
52. First things first. 
53. It’s raining cats and dogs. 
54. Only one at a time. 
55. What would you do? 
56. Listen carefully. 
57. Where are we going? 
58. Where is your book? 
59. You need to do this. 
60. Do you feel ill? 
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61. What did you say? 
62. You’ve got to be kidding. 
63. Do you think so? 
64. Things are looking better. 
65. Not at this time. 
66. Have you seen this? 
67. Where are you going? 
68. Do you know the answer? 
69. Is that my pen? 
70. Do you have any more? 
 
71. I feel great today. 
72. Is it raining outside? 
73. I like this one, too. 
74. How could that happen? 
75. What did she say? 
76. Let’s not go there. 
77. Time for discussion. 
78. It’s time for your test. 
79. It must be… 
80. Do you expect me to believe that? 
 
81. I don’t understand. 
82. Give it to me. 
83. Did he miss the bus? 
84. Please take this to the office. 
85. Now that’s a surprise. 
86. Use your quiet voice. 
87. Get a tardy slip. 
88. Here’s your pass. 
89. Take this to the media center. 
90. You did very well. 
 
91. Did you clean out your desk? 
92. Turn in your homework. 
93. Remember that. 
94. Do you have a question? 
95. Good afternoon, class. 
96. Class dismissed. 
97. Roll call. 
98. What a pleasant surprise. 
99. The assignment is due next week. 
100. Sharpen your pencils now. 
 

101. I am grateful for your help. 
102. Speak up! 
103. Close the door. 
104. Open the window. 
105. Listen to the announcements. 
106. Circle time. 
107. It’s really hot today! 
108. Hello, class. 
109. Hello, boys and girls. 
110. Hello, ladies and gentlemen. 
 

111. My name is ___________. 
112. Where were you? 
113. I appreciate that. 
114. Thank you very much. 
115. You may go now. 
116. What’s for lunch? 
117. What is your address? 
118. For goodness sake! 
119. How about that? 
120. It’s too noisy in here. 
 
121. I’m happy to meet you. 
122. I don’t believe it. 
123. It’s the truth. 
124. Like it or not, it’s true. 
125. Where did you hear that? 
126. Come on, now! 
127. It’s really true. 
128. Sorry to hear about that. 
129. I wish I could help you. 
130. How do you do? 
 
131. How are you? 
132. Get out your pads and pencils. 
133. Take out your laptop. 
134. Take care. 
135. I’m sorry. 
136. That’s terrible news. 
137. How do you spell your name? 
138. Tell me all about it. 
139. It’s about time. 
140. After all this time… 
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141. Once upon a time… 
142. That’s all I know about it. 
143. Where have you been? 
144. It always happens. 
145. I believe so. 
146. He knows better 
147. Just between you and me… 
148. Bring it here. 
149. I’m glad to meet you. 
150. Can you do this? 
 

151. I don’t care. 
152. Did you know that? 
153. I don’t know about that. 
154. Turn the page, please. 
155. Can you find it? 
156. He’s feeling fine. 
157. I have to go. 
158. Can you hear me? 
159. What did I say? 
160. What did I tell you? 
 
161. Hello there. 
162. Happy birthday! 
163. Are you interested? 
164. This is very important. 
165. How are you feeling? 
166. How did this happen? 
167. Wait just a minute. 
168. Just a second… 
169. Do you have time to do this? 
170. What time is it? 
 
171. That didn’t work. 
172. I can’t find it. 
173. Where is your assignment? 
174. I need to call your parents. 
175. What’s the matter? 
176. What’s wrong? 
177. That’s too bad. 
178. You’re in trouble now! 
179. Turn on the lights. 
180. Put away your books. 

181. We will have a test on _______. 
182. Where did you get that? 
183. That’s cute. 
184. That’s funny. 
185. That’s hilarious. 
186. She was first. 
187. You need to study. 
188. See me after class. 
189. What’s the score? 
190. Who won the game? 
 
191. Please erase the board. 
192. Turn on your computers. 
193. No school tomorrow. 
194. Don’t interrupt now. 
195. Where did he go? 
196. What did you find? 
197. What time is it? 
198. Yes, I can. 
199. Yes, you may. 
200. That’s wrong. 
 
201. He’s right. 
202. See you later. 
203. No, I didn’t say that. 
204. I just barely made it. 
205. What’s up? 
206. Hang in there. 
207. What’s the rush? 
208. Time to line up. 
209. Go wash your hands. 
210. It’s a fire drill. 
 
211. My goodness! 
212. Holy cow! 
213. What do you think about that? 
214. Help me, please. 
215. No gum chewing!  
216. May I have your attention? 
217. What does this mean? 
218. Tell me about it. 
219. Turn it on now. 
220. Be quick about it. 
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221. What is it made out of? 
222. That will be fine. 
223. Take care of it right away. 
224. Take a break. 
225. Oh, good! 
226. What is that? 
227. Here we go. 
228. Where are you going? 
229. Everything’s all right. 
230. It’s time to go. 
 
231. I’ll think it over. 
232. Call me later. 
233. What’s new? 
234. It’s nice and quiet in here. 
235. How are you doing? 
236. How’s it going? 
237. Time’s up. 
238. How do you know? 
239. Do you have change? 
240. What time is it? 
 
241. Where’s your paper? 
242. How much time do we have? 
243. Where do you work? 
244. What time did you go to bed? 
245. School is over at ________. 
246. What’s your address? 
247. How is your family? 
248. My watch is slow. 
249. Did you tell him about it? 
250. Good bye. 
 
251. All right. 
252. Look out! 
253. How have you been? 
254. Neatness counts! 
255. How much was it? 
256. Excuse me. 
257. Pardon me. 
258. Where are you going? 
259. When will you be finished? 
260. What time is practice? 
 

261. Practice makes perfect. 
262. I cannot remember that. 
263. Did you forget? 
264. Of course. 
265. You look very nice today. 
266. Aren’t you feeling well? 
267. What happened here? 
268. It’s all over. 
269. It’s all over but the shouting. 
270. OK 
 
271. Did you like it? 
272. What grade did you get? 
273. Did you pass? 
274. I’ll see you tomorrow. 
275. What number is it? 
276. I know all about it. 
277. Just give me the facts. 
278. I’d better go now. 
279. Do you understand this? 
280. So, what do you think? 
 
281. Come back again. 
282. I can’t stand it anymore. 
283. It’s your turn. 
284. Turn out the lights. 
285. What day is it? 
286. What time does it come on? 
287. The pencil is broken. 
288. Watch it! 
289. What time is it now? 
290. Who won the game? 
 
291. It won’t last that long. 
292. Answer the question, please. 
293. Don’t play games with me. 
294. You have a lot of homework. 
295. Is your brother in high school? 
296. Where’s your sister? 
297. We have plenty. 
298. One day at a time…. 
299. Did you trick me? 
300. See you next year. 
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301. Is that an appropriate response? 
302. Remember your manners. 
303. Be polite. 
304. What is the meaning of this? 
305. That’s wonderful. 
306. That’s marvelous. 
307. That’s super. 
308. It’s “A OK”. 
309. Your score is 100%. 
310. We have 10 minutes left. 
 
311. Can you change this, please? 
312. I bought it for a song. 
313. When it rains it pours! 
314. How did that happen to you? 
315. It just doesn’t seem fair. 
316. Where’s your buddy? 
317. This is your last chance. 
318. What’s the rush? 
319. What’s the funny business? 
320. I didn’t say anything 
 
321. Is that an appropriate response? 
322. Remember your manners. 
323. Be polite. 
324. What is the meaning of this? 
325. That’s wonderful. 
326. That’s marvelous. 
327. That’s super. 
328. It’s “A OK”. 
329. Your score is 100%. 
330. We have 10 minutes left. 
 
331. Can you change this, please? 
332. I bought it for a song. 
333. When it rains it pours! 
334. How did that happen to you? 
335. It just doesn’t seem fair. 
336. Where’s your buddy? 
337. This is your last chance. 
338. What’s the rush? 
339. What’s the funny business? 
340. I didn’t say anything 
 

Add more common phrases, sentences, and 
colloquial speech that are characteristic of 
the speaker’s language and speech patterns. 
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Regulatory Authority Related to Communication Accessibility  

Communication accessibility is addressed in various federal regulations, 
such as the Americans with Disabilities Act of 1990 (ADA), Assistive 
Technology Act of 1998, the Individuals with Disabilities in Education 
Act of 1997 (IDEA), and the Rehabilitation Act Amendments of 1998. 
The following is a summary of key legislation related to communication 
accessibility for Persons with Disabilities and links to full text of the 
regulatory acts. 

Americans with Disabilities Act (ADA) of 1990 

The Americans with Disabilities Act, Public Law 336 of the 101st 
Congress, was signed into law on July 26, 1990. The purposes of the ADA 
are to: (1) provide a clear and comprehensive national mandate for the 
elimination of discrimination against individuals with disabilities; (2) 
provide clear, strong, consistent, enforceable standards addressing 
discrimination against individuals with disabilities; (3) ensure that the 
Federal Government plays a central role in enforcing the standards 
established in this Act on behalf of individuals with disabilities; and (4) 
invoke the sweep of congressional authority, including the power to 
enforce the fourteenth amendment and to regulate commerce, in order to 
address the major areas of discrimination faced day-to-day by people with 
disabilities. The ADA prohibits discrimination and ensures equal 
opportunity for persons with disabilities in employment, State and local 
government services, public accommodations, commercial facilities, and 
transportation. It also mandates the establishment of TDD/telephone relay 
services. Section 3 (1) of the ADA specifically addresses auxiliary aids 
and services for persons with disabilities and includes: (1) qualified 
interpreters or other effective methods of making aurally delivered 
materials available to individuals with hearing impairments; (2) qualified 
readers, taped texts, or other effective methods of making visually 
delivered materials available to individuals with visual impairments; (3) 
acquisition or modification of equipment or devices; and (4) other similar 
services and actions. If  you would like further information vist the web 
page: www.usdoj.gov/crt/ada/pubs/ada.txt.  

Assistive Technology Act of 1998 

The act authorizes the State to pay for expenses and The Assistive 
Technology Act of 1998 (P.L. 105-394, formerly the Technology-Related 
Assistance for Individuals with Disabilities Act of 1988) supports 
programs of grants to States to address the assistive technology needs of 
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individuals with disabilities, and for other purposes. The original 
Technology-Related Assistance for Individuals with Disabilities Act of 
1988 was the first time the importance and necessity of assistive 
technology in everyday life was clearly defined at the national level. P.L. 
105-394 establishes the mandatory and discretionary activities for any 
State receiving continuity grants for assistive technology for individuals 
with disabilities to states that have received less than ten years of funding 
under the Technology-Related Assistance for Individuals with Disabilities 
Act of 1988. The Act also authorizes States to enter cooperative 
agreements with other States to expand their capacity to assist individuals 
with disabilities of all ages to learn about, acquire, use, maintain, adapt, 
and upgrade assistive technology devices and services. Furthermore, the 
act authorizes States to operate or to participate in a computer system 
through which the State may communicate electronically with other States 
to gain timely technical services necessary for access to the 
comprehensive statewide program of technology-related assistance by 
individuals with disabilities in financial need who are ineligible for such 
services through another public agency or private entity. 

Individuals with Disabilities Education Act (1997) (IDEA) 

The Individuals with Disabilities Education Act (IDEA) (formerly called 
P.L. 94-142 or the Education for all Handicapped Children Act of 1975) 
requires public schools to make available to all eligible children with 
disabilities a free appropriate public education in the least restrictive 
environment appropriate to their individual needs. President Bill Clinton 
signed the Individuals with Disabilities Education Act Amendments of 
1997 (P.L. 105-17) on June 4, 1997. The Final IDEA ‘97 Regulations 
were released on Friday, March 12, 1999. This Act strengthens academic 
expectations and accountability for the nation’s 6.1 million children with 
disabilities and bridges the gap that has too often existed between what 
children with disabilities learn and what is required in regular curriculum. 
IDEA requires public school systems to develop appropriate 
Individualized Education Programs (IEPs) for each child. The specific 
special education and related services outlined in each IEP reflect the 
individualized needs of each student. IDEA also mandates that particular 
procedures be followed in the development of the IEP. Each student’s IEP 
must be developed by a team of knowledgeable persons and must be at 
least reviewed annually. The team includes the child’s teacher; the parents, 
subject to certain limited exceptions; the child, if determined appropriate; 
an agency representative who is qualified to provide or supervise the 
provision of special education; and other individuals at the parents’ or 
agency’s discretion. Among the significant changes in the revision of the 
IDEA is the focus on student’s accessibility to education in the regular 
education curriculum and access to participation in general assessments 
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that are provided to all other students. Another key feature of the IDEA is 
that assistive technology must be considered for every student for whom 
an IEP is developed. The final amendments were published in the Federal 
Register on March 12, 1999. If you would like further information, see: 
www.edu.gov/IDEA. 

Rehabilitation Act 

The Rehabilitation Act prohibits discrimination on the basis of disability 
in programs conducted by Federal agencies, in programs receiving Federal 
financial assistance, in Federal employment, and in the employment 
practices of Federal contractors. The standards for determining 
employment discrimination under the Rehabilitation Act are the same as 
those used in title I of the Americans with Disabilities Act. Of particular 
interest are Sections 504 and 508. 

Section 504 states that “no qualified individual with a disability in the 
United States shall be excluded from, denied the benefits of, or be 
subjected to discrimination under” any program or activity that either 
receives Federal financial assistance or is conducted by any Executive 
agency or the United States Postal Service. Each Federal agency has its 
own set of section 504 regulations that apply to its own programs. 
Agencies that provide Federal financial assistance also have section 504 
regulations covering entities that receive Federal aid. Requirements 
common to these regulations include reasonable accommodation for 
employees with disabilities; program accessibility; effective 
communication with people who have hearing or vision disabilities; and 
accessible new construction and alterations. Each agency is responsible for 
enforcing its own regulations.  

Section 508 establishes requirements for electronic and information 
technology developed, maintained, procured, or used by the Federal 
government. Section 508 requires Federal electronic and information 
technology to be accessible to people with disabilities, including 
employees and members of the public. An accessible information 
technology system is one that can be operated in a variety of ways and 
does not rely on a single sense or ability of the user. For example, a 
system that provides output only in visual format may not be accessible to 
people with visual impairments and a system that provides output only in 
audio format may not be accessible to people who are deaf or hard of 
hearing. Some individuals with disabilities may need accessibility-related 
software or peripheral devices in order to use systems that comply with 
Section 508.  
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The Architectural and Transportation Barriers Compliance Board (Access 
Board) issued final accessibility standards for electronic and information 
technology covered by section 508 of the Rehabilitation Act Amendments 
of 1998 on December 21, 2000. Section 508 requires the Access Board to 
publish standards setting forth a definition of electronic and information 
technology and the technical and functional performance criteria necessary 
for such technology to comply with section 508. Section 508 requires that 
when Federal agencies develop, procure, maintain, or use electronic and 
information technology, they shall ensure that the electronic and 
information technology allows Federal employees with disabilities to have 
access to and use of information and data that is comparable to the access 
to and use of information and data by Federal employees who are not 
individuals with disabilities, unless an undue burden would be imposed on 
the agency. Section 508 also requires that individuals with disabilities, 
who are members of the public seeking information or services from a 
Federal agency, have access to and use of information and data that is 
comparable to that provided to the public who are not individuals with 
disabilities, unless an undue burden would be imposed on the agency. On 
April 25, 2001, the General Services Administration issued a final rule 
that incorporates the standards into the Federal government’s procurement 
regulations and establishes the effective date as June 25, 2001. For further 
information on Section 508 compliance go to 
www.section508.gov/docs/Final99607A.htm. For further information on 
the Rehabilitatin Act: www.usdoj.gov. 

Information on ADA accessibility issues and Section 508 compliance also 
is available on the Architectural and Transportation Barriers Compliance 
Board’s website www.access-board.gov and the Section 508 website at 
www.section508.gov.  
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Glossary 

accuracy 
An expression of correctly translated words that match spoken words, usually 
expressed as a percentage. 

ambient noise 
Surrounding sounds present in any typical environment, such as that of traffic, 
coughing, distant conversation, or equipment noise. 

ASL 
An acronym for American Sign Language. 

American Sign Language 
The native language of many individuals who are deaf or hard of hearing. ASL is 
a visual language characterized by facial expression, lip movement, and hand 
gestures. 

close button 
The small “X” in the top-right corner of each iCommunicator Window. Click the 
close button to close that specific window. Clicking the Control window’s close 
button exits the iCommunicator program. 

Cochlear implant 

An electronic device surgically implanted into the inner ear that enables a person 
who is deaf hear sound when using an external speech processor. 

Control window 
The portion of the iCommunicator interface that allows you to manage the three 
windows and their functions. 

CPU 
Central Processing Unit. The part of the computer that processes information 
input. 
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custom words 
Subject-specific vocabulary added to the program by the user (indicated by a red 
star). 

defaults 
A program’s original settings and configurations. 

filename extension 
The suffix at the end of a filename that includes a period and up to three 
characters. The filename extension usually describes the file type. 

floating window 
In the Windows 98 and 2000 environments, floating windows are rectangular 
containers that can be dragged to a different portion of the computer screen. 

FM system 
An FM system operates on a radio frequency to provide a listener with a clear 
acoustic signal that is uninterrupted by ambient noise. The system consists of a 
receiver and a transmitter. This type of assistive listening device may be used 
instead of or in conjunction with a hearing aid, and may be coupled with the 
iCommunicator. 

function keys 
Specialty keys, labeled with an “F,” which perform specific tasks when pressed. 

frequency 
A specific, unique wavelength by which a signal is broadcast and received. A 
radio station’s signal is broadcast on a specific frequency. 

icon 
A small graphical representation of an element in a graphical user interface. 
Clicking an icon performs some kind of action (e.g., clicking a magnifying glass 
icon to resize a window). 

memory 
Also referred to as RAM (Random Access Memory). The computer’s workspace 
(physically, a collection of computer chips usually located within integrated 
circuit chips). Memory determines the size and number of programs that can be 
open at the same time, as well as the amount of data that can be processed. 

menu 
A list of available commands in an application window. 

microphone status bar 
A graphical area of the Control Window that indicates when the program is 
monitoring sound input from the microphone. 
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RAM 
See Memory. 

receiver 
A device that receives the signal broadcast by the transmitter. To work properly, 
both the transmitter and receiver must be set to the same frequency. 

shortcut key 
A key or combination of keys that you press to carry out a specific command 
without accessing a menu. 

signing 
The act of communicating with sign language. 

Signing window 
Displays sign language and fingerspelling videos. 

Text window 
The portion of the iCommunicator interface that displays speech that was 
translated into text. 

themes 
Color schemes and border displays, which change the appearance of the 
iCommunicator interface.  

transmitter 
A device that broadcasts a signal. 

voice training 
The process of teaching the iCommunicator software what your voice sounds like, 
so that it can recognize and translate your speech with accuracy. 

Y-cable 

An audio cord that enables a signal coming from a single port to be connected to 
two ports. The iCommunicator uses the y-cable to direct a signal to both external 
speakers and to a hearing assistive device. 
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Index 
A 

Accuracy Check 
phonetically balanced paragraphs, 129 

Accuracy Check #1, 89, 92 
Accuracy Checks, 75, 112 
Acronyms and other unique text 

adding, 98 
Adapting Vocabulary 

vocabulary builder, 104 
Add New Words 

vocabulary, 102 
Adding and Training Words 

vocabulary editor, 106 
American Sign Language, 4 
Americans with Disabilities Act (ADA) of 1990, 138 
Analyze documents 

vocabulary building, 98 
Analyze Documents, 101 
Answer Key 

module reviews, 151 
Assistive Technology Act of 1998, 138 
Audio Quality 

factors, 79 
Audio Wizard 

rerun, 74 
Audio Y-cable Connector, 25 

B 
Babylon Electronic Dictionary, 61 
Battery Indicator, 33 
BestMatch III speech model, 77 

C 
Calculating recognition Accuracy, 130 
Calibrating the Microphone, 79 
Calibration 

microphone, 79 
Changing 

font size, 59 
windows theme, 60 

Chart 
compute accuracy, 130 

Clear Text When Starting, 60 
Clear Text Window When Starting, 44 
Clearing 

text window, 59 
Close 

text window, 60 
Color Codes 

microphone status bar, 57 
Communication 

Accessibility Challenge, 2 

Compute Accuracy Chart, 130 
Continuous Speech Recognition 

overview, 72 
Control Window, 36, 53, 54 
Correct That 

purpose, 108 
using, 108 

Create 
new user, 77 

Create a New User, 77 
Create New Speaker, 77, 128 
Current Speaker, 36 

selecting, 55 
Current Speaker Indicator, 54 
Custom Mode 

minimize & restore windows, 65 

D 
Defaults 

returning to, 40 
Disable Signing, 51 
dongle, 7, 25 

E 
Editing 

quick say keys, 44 
Electronic Dictionary 

Babylon, 61 
Enable Signing, 51 

F 
Font 

changing size, 59 
Font Menu, 52 

G 
General Speech/Voice Training 

running, 90 

H 
Hardware Dongle, 25 
Hearing Loss 

impact of, 2 
Help 

contents, 53 
Help Menu, 52 

I 
iCommunicator 
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10 tips for success, 114 
benefits, 7 
fully integrated, 7 
real-time translation, 6 

Individuals with Disabilities Education Act (1997) 
(IDEA, 139 

Initial Speech and Voice Recognition Training 
overview, 76 

iText Tool, 45 

L 
LightSPEED, 7, 18 
LightSPEED LES 360 System, 21 
Literacy Deprivation 

impact of, 3 
Lock Signing, 44 

M 
Menu 

font, 52 
help, 52 
signing options, 51 
views, 39 

Menus 
options, 41 

Microphone Status 
color codes, 57 

Microphone Status Bar, 57 
on/off, 57 

minimum hardware specifications, 20 
Module Review 

answer key, 151 

N 
New User 

create, 77 
New User Wizard, 86 
Note This, 56 

O 
Open 

text window, 60 
Options 

signing window, 62 
Options Menu, 41 
Overview 

continuous speech recognition, 72 
initial speech/Voice Recognition Training, 76 

P 
Parrot, 7 
Parrott Bermuda Microphone, 25 
Phonetically Balanced Paragraphs 

accuracy checks, 129 

Q 
Quick Say Keys 

editing, 44 

R 
Rehabilitation Act, 140 
Rerun Audio Wizard, 74 
Resizing 

text window, 60 
Retrieving a Sign for a Word, 61 
Return to Defaults, 40 
Run General Training, 90 

S 
Saving 

speech/voice files, 98 
text window contents, 59 

Saving speech/voice files, 98 
Say This/Note This, 55 
Scanning Documents 

for vocabulary building, 99 
Select 

current speaker, 55 
Set Talking Voice, 42 
Sign Language 

availability in U.S., 4 
Signing 

enable/disable, 51 
words in text window, 61 

Signing Locked, 44 
Signing Options Menu, 51 
Signing window, 37, 53 
Signing Window, 40 

increase/decrease size, 65 
options, 62 

Speak Incoming Words, 42 
Special Communication Needs, 3 
Speech and Voice Recognition 

training tips, 73, 112 
Speech and Voice Recognition Training, 71 
Speech/voice File 

fine tuning, 75 
Speech/Voice Recognition File 

fine tuning, 112 
Speech/Voice Recognition Training 

common phrases & sentences, 131 
Speech/Voice Training 

common phrases and sentences, 131 
Status bar 

microphone, 57 
System Check, 26, 71 

T 
Talking Voice 

choosing, 42 
setting pitch and rate, 43 

Text Window, 58 
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clearing, 59 
close, 60 
features, 58 
opening, 60 
resizing, 60 
saving the contents, 59 

Train Words 
vocabulary builder, 104 

Training Tips 
speech/voice recognition, 73 

U 
Using 

correct that, 108 
Using 

Electronic Dictionary, 61 

V 
View 

current speaker list, 55 
Views Menu, 39 
Vocabulary Builder 

adapting vocabulary, 104 
add new words, 102 
Analyzing Documents, 99 
train words, 104 

vocabulary building 
analyze documents, 98 

Vocabulary Building 
general tips, 97 
preview, 96 
scan documents, 99 

Vocabulary Editor 
adding and training words, 106 
getting ready, 106 
purpose, 105 

W 
Windows 

control, 53 
signing window, 62 
text window, 58 

Windows Theme 
changing, 60 
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Module Review Answer Key 
Module 1 

1 False 
2 False 
3 True 
4 True 
5 True 
6 False 
7 False 
   

Module 2 
1 True 
2 True 
3 False 
4 True 
5 False 
6 d 
7 d 
   

Module 3 
1 True 
2 True 
3 True 
4 False 
5 False 
6 d 
7 d 
8 c 
   

Module 4 
1 False 
2 True 
3 False 
4 True 
5 true 
6 a 
7 d 
  

 


